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In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the warranty period
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General Safety Summary

General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.
To avoid potential hazards, use this product only as specified.
Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use Proper Power Cord. Use only the power cord specified for this product and certified for the country of use.

Ground the Product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult
the product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category Il IlI, or IV circuits.

Power Disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it
must remain accessible to the user at all times.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.
Replace Batteries Properly. Replace batteries only with the specified type and rating.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual's installation instructions for details on installing the product so it has
proper ventilation.
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General Safety Summary

Terms in this Manual

These terms may appear in this manual:

c WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

c CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product

These terms may appear on the product:

= DANGER indicates an injury hazard immediately accessible as you read the marking.

= WARNING indicates an injury hazard not immediately accessible as you read the marking.
= CAUTION indicates a hazard to property including the product.

The following symbol(s) may appear on the product:

A @ + b

CAUTION Protective Ground X
RefertoManual  (Earth) Terminal ~ Chassis Ground  Standby
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Environmental Considerations

Environmental Considerations

This section provides information about the environmental impact of the product.

Product End-of-Life Handling

Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The
equipment may contain substances that could be harmful to the environment or human health if improperly handled at the
product’s end of life. In order to avoid release of such substances into the environment and to reduce the use of natural
resources, we encourage you to recycle this product in an appropriate system that will ensure that most of the materials are
reused or recycled appropriately.

The symbol shown below indicates that this product complies with the European Union’s requirements according to Directive
2002/96/EC on waste electrical and electronic equipment (WEEE). For information about recycling options, check the
Support/Service section of the Tektronix Web site (www.tektronix.com).

Mercury Notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due
to environmental considerations. Please contact your local authorities or, within the United States, the Electronics Industries
Alliance (www.eiae.org) for disposal or recycling information.

Restriction of Hazardous Substances

This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS
Directive. This product is known to contain lead, cadmium, mercury, and hexavalent chromium.
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Preface

Preface

This manual describes the installation and basic operation of the RSA6100A Series of real-time spectrum analyzers. For
more detailed information, see the online help for your instrument.

Key Features
The RSA6100A Series is a family of high-performance real-time spectrum analyzers. Key features include:

m Easy event-based capture of transient RF signals by triggering on changes in the frequency domain using
Tektronix-exclusive Frequency Mask Triggering

= Digital Phosphor Spectrum analysis, which greatly reduces the amount of time to recognize and identify a fault
®  Seamless capture of signals in up to 110 MHz spans

= Multi-domain displays that provide an intuitive understanding of time-varying RF signals

® Display of signal instabilities and transients that are difficult or impossible for other signal analyzers to catch

m  Search compares Spectrum traces to user-defined limit lines and masks for pass/fail testing

Documentation

The following documentation is available with your Tektronix RSA6100A Series Spectrum Analyzer. For the most current
documentation, refer to the Tektronix Web site.

To read about Use these documents

Installation and operation (overviews) RSA6100A Series Real-Time Spectrum Analyzers Quick Start User
Manual. The quick start user manual contains general information about
how to put your instrument into service, guides to user interface controls,
and application examples.

In-depth operation and user interface help RSA6100A Series Real-Time Spectrum Analyzers Online help. The online
help contains detailed information about how to operate the instrument.

Programming Commands RSA6100A Series Real-Time Spectrum Analyzers Programer Manual. The
programming commands for the RSA6100A Series are located in a PDF
file located on the RSA6100A hard disk and on the product software CD.

Specifications and Performance Verification RSA6100A Series Real-Time Spectrum Analyzers Specifications and
Performance Verification Manual. This manual contains the instrument
specifications and a procedure to check instrument performance against
warranted characteristics. This manual is in a PDF file located on the
RSA6100A hard disk and on the product software CD.

User Service RSA6100A Series Real-Time Spectrum Analyzers Service Manual.
An optional manual that provides a list of replaceable parts, care and
maintenance information, and information for servicing the instrument to
the module level.
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Preface

Software Upgrades

Software upgrades are available. Software upgrades become operational only after you enter a valid option key for the
specific spectrum analyzer model and serial number.

To check for upgrades:
1. Go to the Tekironix Web site (www.tektronix.com).
2. Select Software and Drivers to link to the Software and Firmware Finder Web page.

3. Enter the product name (RSA6100A) to find available software upgrades.

Conventions Used in This Manual

The following icons are used throughout this manual:

Sequence Front panel Connect Network PS2 SVGA USB
Step power power

w000 0C
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Installation

Installation

Before Installation

Unpack the instrument, and check that you received all items listed as Standard Accessories. Optional accessories and
instrument options are also listed in this section. Check the Tektronix Web site (www.tektronix.com) for the most current
information.

Standard Accessories

Your instrument comes with the following accessories: quick start user manual (languages are listed below), programmer
manual (on CD), specifications and performance verification manual (on CD), power cord, BNC-N adapter, USB keyboard,
USB mouse, and instrument pouch.

Documents
B RSA6100A Series Real-Time Spectrum Analyzers Quick Start User Manual is available in the following languages:
= English, Tektronix part number 071-1909-XX.
= Simplified Chinese, Tektronix part number 071-1910-XX.
= Japanese , Tektronix part number 071-1911-XX.
= Russian, Tektronix part number 071-1912-XX.

B RSA6100A Series Real-Time Spectrum Analyzers DocumentsCD, Tektronix part number 063-3930-XX. The Documents
CD contains PDF versions of the following manuals:

= RSA6100A Series Real-Time Spectrum Analyzers Quick Start User Manual, in English, Japanese, Russian and
Simplified Chinese.

= RSA6100A Series Real-Time Spectrum Analyzers Programer Manual., Tektronix part number 071-1913-XX.

= RSA6100A Series Real-Time Spectrum Analyzers Specifications and Performance Verification Manual, Tektronix
part number 071-1915-XX.

= RSA6100A Series Real-Time Spectrum Analyzers Declassification and Security Instructions, Tektronix part number
071-2056-XX.

Power Cords

The RSAG100A Series Real-Time Spectrum Analyzers are shipped with one of the following power cord options. Power
cords for use in North America are UL listed and CSA certified. Cords for use in areas other than North America are approved
by at least one authority acceptable in the country to which the product is shipped.

International Power Plugs
B Opt. A0 - North America power
®  Opt. A1 - Universal EURO power
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Installation

= Opt. A2 - United Kingdom power

B Opt. A3 - Australia power

m  Opt. A4 -240 V, North America power
®  Opt. A5 - Switzerland power

= Opt. A6 - Japan power

®  Opt. A10 - China power

® Opt. A11 - India power

®  Opt. A99 - No power cord

Optional Accessories
®  RSA6100A Series Real-Time Spectrum Analyzers Service Manual, Tektronix part number 071-1914-XX.
m RSAB1RHD - Provides an additional removable hard disk drive for use with Option 06

B (65-0765-XX - Additional removable solid-state hard drive for use with Option 08 (Windows XP and instrument SW
pre-installed)

Options
You can add the following options to your spectrum analyzer:
= Option 01 - Adds 10 MHz to 3 GHz Pre-Amplifier
B QOption 02 - Adds frequency mask triggering and RAM expansion
= QOption 05 - Adds digital 1Q output and 500 MHz analog IF output
= QOption 06 - Adds a removable hard disk drive (not compatible with Option 07 or Option 08)
= Option 07 - Adds a DVD+RW drive, no-cost option (not compatible with Option 06 or Option 08)
B QOption 08 - Removable solid-state hard drive (not compatible with Option 06 or Option 07)
= QOption 20 - Adds advanced signal analysis (including pulse measurements)
= QOption 21 - Adds general-purpose digital modulation analysis
= Option 110 - Adds 110 MHz real-time capture bandwidth
B Option 1R - Adds Rackmount Kit

2 RSA6100A Series Quick Start User Manual



Operating Considerations

Power Supply Requirements

Source Voltage and Frequency

Installation

Power Consumption

100 — 240 Vrus, 50/60 Hz
115 VRMSy 400 Hz

600 W maximum

Environmental Requirements

Characteristic

Description

Operating temperature

+5 °C to + 50 °C
(+5 °C to +40 °C; when accessing the DVD
drive or optional removable hard-disk drive)

Non-operating temperature

-20 °C to +60 °C

Humidity 90% at 30 °C (non-condensing)
80% maximum when accessing the DVD drive
Maximum wet-bulb temperature 29 °C
Altitude:
Operating Up to 3000 m (9843 ft)

Non-operating

12190 m (40,000 ft)

Cooling clearance
Bottom
Sides and back

20 mm (0.79 in)
50 mm (1.97 in)

18.6in 20.901in
- (473. mm) - (530.86 mm) -
| ] 9
. 0
1.1in X
(282. mm) o
0
@ ©
/000000 000000000
Do \u/m| OOy Aoooodd 0O0000000
/ 0000000 000000000
00000000000 OOO00000000000 000000000
00000000000 O0000000000000 000000000
‘ ’ @ @ [ OOO00000000000 o o o
& U 1909-005

CAUTION. To ensure proper cooling, do not operate the instrument on its side. Operate the instrument only when it is resting
on its feet, located on the bottom of the case. Maintain at least 2 inches (5 cm.) clearance around ventilation openings.

WARNING. To avoid personal injury, take extra care when lifting or moving the spectrum analyzer. The instrument is

somewhat heavy and requires extra care when moving it.
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Installation

Connecting to the Instrument

Connecting to a Network

Connect your keyboard, mouse, printer, and other accessories to your instrument before applying power. (Accessories with
USB connectors can be connected before or after applying power.)

You can connect your instrument to a ‘

network for printing, file sharing, Internet _

access, and other functions. Consult your = -5

network administrator and use the standard SSiE @ !

Windows utilities to configure the instrument cese oo

for your network. 8835-55 /e

Quick Tip

= |f you connect your instrument to a network, you should protect your instrument by using an internet firewall, installing
regular approved operating system updates, and using up-to-date antivirus software.

Powering On the Instrument

1909-008
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Installation

Powering Off the Instrument

q ( ) ] —

o
o O C)C)
(/ y
CcCOoOOoOoOOo
= cooco © O
= cooco O O
coocoo O O

Removing the Power

1909-010
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Adding an External Monitor

Use the following procedure to add an external monitor for dual monitor configuration. Both the spectrum analyzer and
the second monitor must have the color set to True Color.

1. Power off the spectrum analyzer and the
external monitor.

2. Connect the external monitor to the
spectrum analyzer.

3. Power on the spectrum analyzer and the
external monitor.

N /
/ N
9 [
— "~
J 1909-007

1909-013
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Installation

4. Open the Windows Control Panel.

B Control Panel

File

Edit View Favorites Toadls Help a.

e Back - w\) LI )’j Search lfj Folders v tr
9 Control Panel v ‘ Go

Name = Comments >
!!pnccessmmty Options
& add Hardware
L9Add or Remave Programs Install or remove pr
@ administrative Tools Configure administr
& sutomatic Updates Set up Windows ta

5. Double-click Intel(R) Extreme Graphics
2 M to open the properties page.

Address

Adjust your comput
Installs and trouble

ﬂ’ Control Panel k]

@ Switch to Category View

See Also “PDate and Time Set the date, time,
6 Windows Update }D\splay Change the appear
e 7 | Folder Options Customize the displ
©) Heb and Support MEVESER EYFonts Add, change, and .
& Game Contrallers Add, remove, and ¢
Control the graphic
9Internet Cptions Configure your Inte
#mKeyboard Customize your key
':)Mouse Customize your mo

Bk Came b Famnncbe ko nbhae oo

1l 3 .

1909017

6. Click Intel(R) Dual-display Clone to
show internal screen (Notebook) content
on an external monitor (Monitor).

Intel(R) B2852/82855 GMIGME Graphics Controller Prope... [ ][]

Devices |EOI0r | Schemesl Hat Keysl Hotationl DpenGLl Informatinnl

! - Setting
g Colors True Caolor vl

Manitar

3 Screen Area 800 by 600 vl
Motebook. Refresh Rate B0 Hz vl

A
e
Intel[R] Dual

Dizplay Clone

44

Extended Desktop

Ok I Cancel Apply

1900-018
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Installation

7. Adjust the settings as necessary and
then click OK to apply the settings and to
close the properties page.

Intel(R) B2852/82855 GMIGME Graphics Controller Prope... [ ][]

Devices ]Eolor ] Schemes] Hat Keys] Hotation] DpenGL] Informatinn]
Extended Desktop Settings
/ Jl

=

M anitar

Motebook.
Frimary Device Moteboaok 7
=

= =_I Secondary Device tanitar -
Intel[R] Dual
Dizplay Clone

E stended Deskiap Device Settings...

@

’_ Uk | Cancel Apply

1903019
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Adjusting the Windows Display Settings

Installation

To change the instrument display settings, use the Intel Graphics Driver instead of the default Windows display properties.
The Intel Graphics Driver provides additional capabilities that are not accessible from the Windows display properties

dialog box.

1. Open the Windows Control Panel.

2. Double-click Intel(R) Extreme Graphics
2 M to open the properties page.

3. Adjust the settings as necessary.

NOTE. Not all of the selections in the
property page will be available if there is no
external monitor connected to the instrument.

4. Click OK to apply the settings and to
close the properties page.

#- Control Panel
Edit

File

@ Back ~ \J

View Favorites Tools Help

{’ /71 Search |{ Folders v 1'f‘

Address | Control Panel

v .Ga

Name =
&Accessibility Options
& Add Hardware
{L)Add or Remove Programs
48 Administrative Tools
“ Automatic Updates
j’Date and Time

Q Windows Update S‘D'SDIEV _
| Folder Options

(7)) Help and Support EFonts
‘& Game Controllers

&" Control Panel ]

G Switch ko Category Yiew

See Also

p
@mKeyboard
) Mouse

[ VYN e

Comments o]
Adjust your comput
Installs and trouble
Install or remove pr
Configure administr
Set up Windows to
Set the date, time,
Change the appear
Customize the displ
Add, change, and .
Add, remove, and ¢
Control the graphic
Configure your Inte
Customize your key
Customize your mo

P T PRI

Intel(R) 82852/82855 GM/GME Graphics Controller Prope... [2)(X]

Devices | Calor I Schemes | Hot Keys | Hotationl UpenGL' Informationl
Settings
'd ]
— Calors True Color -
Manitor
7 Screen Area 800 by 600 -
Natebaok. Refresh Rate B0 Hz -
4
Intel(R) Dual
Display Clone
44
Estended Desktop
®
|— 0K I Cancel Apply

1909-111

1909-110

NOTE. Although it is not recommended, you can attach a second monitor after the spectrum analyzer is powered on;
however, after connecting, you will still need to enable the Extended Desktop from the Intel Extreme Graphics 2M control

panel.
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Inspecting the Instrument

Launch the diagnostics application (Tools > Diagnostics). If failures occur, perform the following steps to get more information
about them. You can also use the following steps as a detailed incoming inspection to verify the functionality of your
instrument. If you want to check the accuracy specifications of your instrument, see the RSA6100A Series Real-Time
Spectrum Analyzers Specifications and Performance Verification Technical Reference manual PDF (part number
071-1915-00) located on the Documents CD.

10

1.

Select Tools > Diagnostics.

On the Diagnostics tab, click All
Modules, All Tests.

Click Single Test.

Click Run.

The instrument will run through
the tests one at a time. A check
mark or X icon will appear to the
right of each check box as that
test is completed. The check icon
means the test was passed. The
X means the test was failed.

For tests that require manual
intervention, follow the on-screen
instructions to complete the tests.

IEH Window Help

Alignments

@

Diagnostics

Install Upgrades. ..
Options

1909-020

) Tek RSA6100A - [Diagnostics]

| Diigﬂﬂﬁt\tﬁunise\f'rests Diagnostics Failure Info

| B O @Al Modules, &ll Tests
& Hardware Init
Digital Board
RF Interface
Reference Oscillator
FirstLO
First Converter
Four GHz IF Madule
Second Converter
Third IF
Marrow Band Acouisition Board
\Wide Band Acguisition Board
DPFSA Board
10 Output Board
Attenuator
Signal Path
Front Panel

& B -

B8

o e o o o o o o

4 = X

TestPrograss U

RUMN

Current Series
Count: 0

Date: 9/25/2006
Time: 10:28 AM

Repeat

O Times: ﬁ Eli
O until Fail

O Continuous

& 5ingle Test

| Exit Diagnostics
o

1909021

NOTE. Select the Diagnostics Failure Information tab to see basic diagnostic failure information. Use the Windows Event
Viewer (a subset of the Administrative tools in the Windows Control Panel) to view failure history and nondiagnostic failures
reported by the application.

RSAB6100A Series Quick Start User Manual



Installation

User Maintenance

Cleaning Your Instrument

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-bristle brush. If any dirt remains, use a cloth or
swab dipped in a 75% isopropyl alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do
not use abrasive compounds on any part of the instrument because they might damage the instrument.

CAUTION. Avoid getting moisture inside the instrument during exterior cleaning; use just enough moisture to dampen the

/ ' \ cloth or swab. Do not wash the front-panel On/Standby switch. Cover the switch while washing the instrument. Use only
deionized or distilled water when cleaning. Use a 75% isopropy! alcohol solution as a cleanser and rinse with deionized
or distilled water. Do not use chemical cleaning agents; they might damage the chassis. Avoid chemicals that contain
benzene, toluene, xylene, acetone, or similar solvents.

CAUTION. To prevent damage to the flat panel display, do not use improper cleaning agents or methods. Avoid using
abrasive cleaners or commercial glass cleaners to clean the display surface. Avoid spraying liquids directly on the display
surface. Avoid scrubbing the display with excessive force.

Clean the display surface by gently rubbing the display with a clean-room wipe. If the display is very dirty, moisten the wipe
with distilled water or a 75% isopropyl alcohol solution and gently rub the display surface. Avoid using excess force; this
might damage the display surface.

Upgrading the Instrument Software

Software upgrades are available from Tektronix. They can either be downloaded from the Tektronix Web site or they can be
ordered from your local Tektronix representative. To add additional software options or features, you will need an option key
from Tektronix. When you receive the software from Tektronix, install it on your instrument. When prompted, enter the option
key, and then follow the online instructions to complete the upgrade.

Returning Your Instrument
If you return your instrument to Tektronix:
E  Back up any user software on the hard disk. You may need to reinstall the software after your instrument is returned.

= When repacking the instrument for shipment, use the original packaging. If the packaging is unavailable or unfit for use,
contact your local Tektronix representative to obtain new packaging.

= Seal the shipping carton with an industrial stapler or strapping tape.

RSAB6100A Series Quick Start User Manual 11
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Operation

Getting Acquainted with Your Instrument

Controls and display elements are shown in the following illustrations and tables.

Front Panel Controls

Most front panel controls are shortcuts for opening control panels.

Operation

e ~
o
{ l
@ [ Displays)
@ Settings } ( Freq ) @
Spectrum
@ Trigger ) { Span
@ Acquire ) { Ampl @
@ l Analysis } { BW
Ref number Item Description Menu Equivalent
1 Media DVD or removable hard disk drive
2 Displays Opens the Displays dialog box to select measurement ~ Setup > Displays
displays.
3 Settings Opens the Settings control panel for the selected Setup > Settings
display.
4 Trigger Opens the Trigger control panel. Setup > Trigger
5 Acquire Opens the Acquire control panel. Setup > Acquire
6 Analysis Opens the Analysis control panel. Setup > Analysis
7 Freq Adjusts the measurement frequency. Setup > Analysis >
Frequency tab 2
8 Span (Spectrum) Adjusts the span or frequency range shown in the Setup > Settings >

Spectrum display. 1

Freq & Span' 2

RSAB6100A Series Quick Start User Manual
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Operation

Ref number Item Description Menu Equivalent

9 Amplitude Adjusts the reference level. Setup > Amplitude 2

10 BW (Spectrum) Adijust the resolution bandwidth (RBW). 1 Setup > Settings > BW
tab 1 2

1 Applicable only when the selected display is Spectrum, DPX Spectrum, or Spectrogram.
2 Press and hold for one second to open the associated control panel.

Tab Esc 1
Run @

Markers
Peak

@

Select

G
Define < »
&P

1909-002

@ee®
RGN

Ref number Item Description Menu Equivalent

" Tab Moves the cursor to the next entry in the dialog box
or control panel. Same as pressing the Tab key on an
external keyboard.

12 Run (Stop) Push to start and stop acquisitions. Run > Run

13 Markers, Peak Moves the active marker to the maximum peak of the
trace in the selected display. If markers are turned
off, the MR (marker reference) marker will appear at
the maximum peak.

14 Markers, Select Selects the next marker.

15 Markers, Define Opens the Markers control panel.

16 Esc Exits dialog boxes without saving changes.

17 Control knob Changes values in numeric and list controls. Pressing

the knob (clicking it) is the same as pressing the Enter
key on a keyboard.

18 Arrow keys Move the Markers. The Up arrow moves the selected
marker 10 trace points to the right. The down arrow
moves the selected marker 10 trace points to the left.
The left and right arrows move the selected marker to
the next peak. (Turning the knob moves the marker
one trace point left or right.)

14 RSAB6100A Series Quick Start User Manual
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@ & ) @i (&

@ ® ® @
D @ ® @

@ O 6D ) ()

Operation

N
Ref number Item Description Menu Equivalent
19 Keypad Enters values in controls.
20 Enter Completes the data entry in controls. Same as
pressing the Enter key on the keyboard.
@ Recall ) ( Help @
]
@ o G @)
Touch Screen |1
@ off ) { Preset: @
Ref number Item Description Menu Equivalent
21 Recall Opens the Recall dialog box. File > Recall...
22 Save Saves working file using the same user selections as File > Save
for the previous Save action.
23 Touch Screen Turns the touch screen on and off.
On/Off
24 Help Displays the online help. Help > User Manual
25 Print Opens the Print dialog box. Printouts are a screen File > Print
capture of the RSA6100A application window.
26 Preset Returns the instrument to its default or preset values. Setup > Preset

After a Preset action, the Spectrum Analyzer display
is the only open window.

RSAB6100A Series Quick Start User Manual
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Front Panel Connectors

(

q ! ] | ]
[ o O
o oo
o OO
O OO
O OO o ©
SS38° o o
ocooo o O
coocoo O O
q )
[ e i@ | o
Ref number Item Description
1 Trig Out Trigger output connector. 50 Q, BNC, High > 2.0V, Low < 0.4 V, (output current 1 mA)
2 Trig In External Trigger input connector, -2.5 V to +2.5 V range, trigger level is user
configurable)
3 USB 1.1 USB 1.1 mouse connector
4 USB 2.0 USB 2.0 connector
5 RF Input RF input connector 50 Q

RSAB6100A Series Quick Start User Manual



Rear Panel

Operation
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&
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i
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1909-011

Ref number Connector, Description

1 AC Input, main power connector

2 GPIB

3 IF output (Option 05)

4,5 Real Time 1Q Out (Option 05)

6 Ref In, reference frequency input

7 Ref Out, reference frequency output

8 Headphone, audio output connector

9 External Trigger 2 Input

10 COM 2, serial port for connecting peripherals
1 VGA, external monitor output (resolution not limited to VGA)
12 PS2 Keyboard input

13 USB2 ports for mouse and other USB2 devices
14 TekLink, reserved for future use

15 +28 VDC Output, (switched)

16 LAN, Ethernet network connector

RSAB6100A Series Quick Start User Manual 17
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Interface and Display Elements

Commonly-used buttons and controls are located in the tool bar. Most of the buttons open control panels for changing the
instrument setups. The contents of the control panels vary depending on the selected display. You can also access the

control panels from the front panel buttons or from the keyboard.

mmm-——-[]

n Fil: “iew Run Markers) Setup | Tools [Mindow [ Help
[ElaT] [Eke?][gtting] Trig || Acq || Aha | © Freq: 97.00 MHz 2 RefLev: -40.00 dBm |Ampl [ [Replay || Run
v v Bitmap [¥Show On
% -50.0 dBm
© dBjfdiv:
5.50 dB
~ REW
400 kHz
-115 dBm
& CF: 97.00 MHz % Span: 24,40 MHz
Analyzing | Acg BwW: 40,00 MHz, Acg Length: 2.000 us Real Time | Free Run Ref: Int  Atten: 10 dB8 | Preamp: On, max 2GHz
1909-022
Ref number Item Description
1 Displays Opens the Select Displays dialog box so that you can select measurement
displays
2 Markers Opens or closes the Marker toolbar at the bottom of the window
Settings Opens the Settings control panel for the selected display. Each display
has its own control panel.
Trigger Opens the Trigger control panel so that you can define the trigger settings
5 Acquire Opens the Acquire control panel so that you can define the acquisition
settings
6 Analysis Opens the Analysis control panel so that you can define the analysis

settings such as frequency, analysis time, and units
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Ref number Item Description

7 Center Frequency Displays the Center Frequency. To change the value, click the text and use
the front panel knob to dial in a frequency. You can also enter a frequency
with the front panel keypad or use the front panel up and down buttons.

8 Reference Level Displays the reference level. To change the value, click the text and enter
a number from the keypad or use the front panel up and down buttons.

9 Amplitude Opens the Amplitude control panel so that you can define the Reference
Level, configure internal attenuation, and enable/disable the (optional)
Preamplifier.

10 Replay Runs a new measurement cycle on the existing acquisition data record
using any new settings.

" Run Starts and stops data acquisitions. When the instrument is acquiring

data, the button label has green lettering. When stopped, the label has
black lettering.

You can specify the run conditions in the Run menu. For example, if
you select Single Sequence in the Run menu, when you click the Run
button, the instrument will run a single measurement cycle and stop. If
you select Continuous, the instrument will run continuously until you stop
the acquisitions.

RSAB6100A Series Quick Start User Manual
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Display-Specific Controls

Most displays have commonly-used controls arranged around the graph. They provide quick access to common settings;
the full control set for the display is in the Settings control panel. The following illustration and table show some of the
common icons that appear in most displays.

® @

F‘Flle Wiew Rin  Markers Setup  Tools “Window Help

‘m @E Settings || Trig || Acg || Aha | © Freq: 97.00 MHz 2 RefLev: -40.00 dBm |2mpl | |Replay || Run
< Bitman [¥IShow On

% -50.0 dEm

© dBjfdiv:
6.50 dB

=~ RBW
F00 bz

-115 dEm

& (CF:97.00 MHz ¢ Span: 24.40 MHz

Analyzing  Acg BwW: 40.00 MHz, Acq Length: 2.000 us Real Time | Free Run Ref: Int  Atten: 10 dB8 | Preamp: On, max 2GHz
1909-023

Table 1: Common Icons

Ref number Control icon Description
1 v Drop-down List. Click to select a value from the drop-down
list.
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Table 1: Common Icons (cont.)

Operation

Description

Knob. Click anywhere on the icon or on the text readout
to select the control. You can then change the value with
the front panel control knob or arrow keys, or enter a value
from the keypad.

Ref number Control icon
2 o
Not shown 6.337us

Italicized numbers. These indicate automatically selected
control values. Several controls in the instrument (for
example, RBW and Analysis Length) allow you to select
an Auto mode. In Auto mode, the instrument software
automatically sets the value. You can change the control
to Manual mode by changing the value. To return to Auto
mode, clear the value, and then press the Enter key.

RSAB6100A Series Quick Start User Manual
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Basic Concepts

22

Real Time Spectrum Analyzers

Tektronix Real-Time spectrum analyzers, such as the RSA6100A Series Spectrum Analyzers, have an optional, patented
frequency mask trigger. The frequency mask trigger allows you to set up a spectral mask to capture a signal when a spectral
anomaly occurs. This allows the real time spectrum analyzer to check 100% of the input signal before acquiring, and

then capture precisely the intermittent RF event of interest.

DPX™ technology allows you to view the RF signal as a live display. You can view very short transient signals, multilevel
signals, and time-varying events.

The RSA6100A Series Spectrum Analyzers allow you to view the captured signals in a wide variety of time-correlated
displays. This is useful for device troubleshooting and signal characterization applications. All of the measurements are
based on the same underlying set of time domain sample data.

Measurement Displays

The RSA6100A window can show one or any combination of general purpose and application-specific displays.

This example shows a single DPX Spectrum 71 Tek RSA100A - [DPX Spectrum] EEX
dIS |a W|th|n the WmeW Bl Fle View Run Markers Setup Tools Window Help -8 x
p y < Freq: 97.00 MHz ~ RefLev: -40.00 dBm Replay
v v Bitmap  [Fshow on
& -50.0 dBrmn
< dBfdiv:
6.50 dB
© RBW
400 ke
-115 dBm
© CF: 97.00 MH: © Span: 24.40 MHz
Analyzing  Acg BW: 40,00 MHz, Acg Length: 2.000 us Real Time  Free Run Ref Int  Atten: 10 4B Preamp: On, max 3GHz

1909-024
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This example shows the window with two 2L Tek RSAG100A EEE

. : File View Run Markers Setup Taols Window Help
dlsplaysl a SpeCtrum dISplay and a DPX | Displays | | Markers ||Settings WWW < Freq: 91.500 MHz % RefLev: -40.00 dBm | &/
spectrum display.

= 3

When you have more than one disp|ay v Tracel [FShow +Pesk Nomal v Bitmap [show on
H H H < -40.0 dBm & -50.0 dBm
open, the display with thelc_h.eck mark icon o S
has control over the acquisition hardware. A SE0EY
. . . . o RBW 9 RBW
To give a display priority over any others, Dise Dt
click its title bar.
rw' ‘*
"‘l“ i’mmw er ‘i“ \.|| ”J lln"
-140 dBm -115 dBm L ' /
. S CF: 91,500 MHz 5 span: aslu mHz f [(Autoscale S CF: 91,500 MHz & gpan: 3.810 MHz
Markers v MR Frequency v |91.5 MHz E] E] E] @
Analyzing  Acg BW: 5.00 MHz, Acg Length: 148,450 us Real Time  Free Run Ref Int  Atten: 10dE  Preamp: On, max 3GHz
1909-026
This example shows four displays in the 1 Tek RsA61004 EEE)

File Wiew Run Markers Sstup Tools Window Help

window.

| Markers ||Sattings || Trig || Acq || Ana | & Freq: 91.500 MHz & RefLev: -40.00 dBm
n _[E]5] i peciin _ 5]
v Trace1 [Flshow  +Peak Nomsl

< -40.0 dBm
Marker: MR = dBfdiv:
Time: 500,00 nSym 10.0 de
Mag 8
Phase: “ RBW
Symbol:  — 2
Walue:
r-ﬁ\ v
-140 dBrn
RMS: 43,658 %

Peak EVM: 86.095% @ 34,00 Sym 2 CF: 91.500 MHz = Span: 3.610 MHz
JLRF 18Q vs Time L X

0 v ITrace  []Show  Mormal
© 104 mv

v Bitmap [¥Show On
| © -50.0 dBm
| & cB/div:
6.50 dB
“ REW
50 kHz

= Offety \ I*l‘f LM.I“‘ iy 4‘\4 whu,
"&l”n'fm'"*"WH'Mﬁ'FM“A"[';W% N

© offseti41600us  © Scalsi 33280 us -115 dém

Maxi o42.0u @ 42.24us Min; -5347ud @ 53.75us © CF: 91.500 MHz & Span: 3.810 MHz
Analyzing  Acg BW: 5.00 MHz, Acg Length: 148,450 us Real Time  Free Run Ref Int  Atten: 10dE  Preamp: On, max 3GHz

1909-026

The acquisition data source can be a live acquisition or a saved acquisition data file. The sharing of acquisition data within an
analysis window allows you to view the same data in multiple ways. For example, you can display a power versus frequency
(spectrum) display and a spectrogram diagram at the same time. Because the data source is shared among the different
displays, the displays are correlated. That is, a point or set of points within one display is associated with a point or set of
points in every other display in the application window.
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Navigating Displays

The RSA6100A uses multiple displays to keep operations simple, and yet provide advanced functionality when needed.
Some of the display categories include:

®m  General Signal Viewing displays. These displays show graphs for basic signal parameters such as amplitude, phase,
and frequency plotted against frequency or time. Examples of these displays include: Spectrum, DPX, Spectrogram,
Time Overview, and Phase vs Time.

= General Purpose Digital Modulation displays. These displays show the results of demodulating signals and analyzing
them in multiple domains. Examples of these displays include: Constellation, Symbol Table, and EVM vs Time. These
displays are available with Option 21, General Purpose Modulation Analysis.

®  General Purpose RF Measurement displays. These displays show the results of automated measurements on RF
signals. Examples of these displays include: ACPR, MCPR, and CCDF.

= Pulsed RF displays. These displays show the results of advanced analysis for pulsed RF signals. Examples of
these displays include: Pulse Statistics, Pulse Table, and Pulse Trace. These displays are available with Option 20,
Advanced Signal Analysis.
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Selecting Displays

The spectrum analyzer provides an easy way of selecting displays.

Click Displays to open the Select
Displays dialog box.

)\ Tek RSA6100A - [Spectrum]
B Fle view Run Markers Setup Tools Window Help

EEx

g x

@ [Markers |[settings |[ Trig [ aco |[#ra | © Frea: 1.48200 GHz © RefLev: 0.00 dBm
2. Click the desired application M Select Displays NS
f0|der Idars: ! _ Avalable displays:
The available displays for each 5 Dot vdatn [ [ |
folder are listed in the Available Fuisec! RF AMPHUES i oency  Paeis  REIGES Speciogrem
Displays pane. @ m @
3. Click one of the display icons. o
4. Click Add (or double-click the
icon) to add the selected display
to the Selected displays list.
Repeat the procedure to add other Sl by 4)
displays. 5
5. Click OK to close the dialog
box. The selected displays will @ o p—
automatically open. L= m
Quick Tips
®m  Push the Displays button on the front panel to open the Select Displays dialog box.
®  To add a display, double-click the icon.
= To remove displays, do one of the following:
= Select a display icon in the Selected Displays list, and then click Remove.
= Double-click a display icon in the Selected Displays list.
= Click the Close button in the upper right hand corner of the selected display.
B You can mix displays from multiple application folders.

RSA6100A Series Quick Start User Manual
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Common Information Messages

The following table lists some of the common information messages that might appear during normal operation.

Table 2: Common Information Messages

Message Explanation and recommended action

Acq BW too small for current setup The display needs a wider acquisition bandwidth than the current data record
contains. This can be due to any of the following reasons:

B A display other than the one you intended has been selected. The selected
display has requested a smaller acquisition bandwidth to achieve a better
accuracy or dynamic range for its particular measurement.

Select the display that contains the message. Click Run if the instrument
is not already acquiring data.

®m  Acquisitions are not running and the measurement now requests a wider
bandwidth than the last acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

B The data is from a recalled file.

There is no way to increase the acquisition bandwidth for saved data. You
must adjust the measurement settings so that less bandwidth is required.

Need swept acq or larger Acq BW When any display requires a swept acquisition, the other displays are unable to
process the swept data. This is because the swept data is customized for the
selected display.

Select the display that you are interested in and the acquisition settings will
automatically change to meet the requirements of the selected display.

RBW increased to 100 kHz The current Spectrum Length or Analysis Length is not long enough to allow
a narrower RBW filter.

If the Length control is set to Manual, try increasing it or setting it to Auto so
that the Analysis Length will increase to the required value.
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Changing Measurement Settings

Operation

The displays have settings that control how signals are acquired and processed. The settings that you can change depend

on the selected display.

To access the settings (in this case, for the Spectrum display):

1. Click Settings to open the Settings
control panel.

2. Adjust the controls as needed for your
signal or test. Most of the control panels
have tabs that provide easy access to
other related controls.

Quick Tip

)\ Tek RSA6100A - [Spectrum]
B Fle view Run Markers Setup Tools Window Help -8 x

Markers |[Settings | Trig | aca J[2na | © Frem: 148200 GHz o RefLev: 0.00 dBm

1909-029

@

Spectrum Freq & Span | Bw | Traces | Scale | Prefs
Settings ZaE - E
Center: 91,500 MHz | Span: [3.810 MHz Max Realtime Span
Start: 89,595 MHz Points: 501 v
Stop: 93,405 MHz
Restore : | 200.0000 s o
e Step Siza: | | Baue

Analyzing  Acg BW: 5.00 MHz, Acq Length: 148,480 us Real Time  Free Run Ref Int  Atten: 10 4B Preamp: On, masx 3GHz

1909-030

B [f you have multiple displays on the screen, click anywhere inside one of the other displays to change to the control

panel for that display.

RSAB6100A Series Quick Start User Manual
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Presetting the Instrument

You can preset the instrument to restore the setups to their default values.

1. To start with the default instrument (] )
settings, push the Preset button on the | |
front panel or select Preset from the
Setup menu.
Tab Esc
Spectrum Markers
o
@ |®
O
Bksp
D G (=
@ @ G @w
©@®® ]
x1/dBx  Enter ouch Screen
OO®®® | O
~ 1909-014
Quick Tip

B Preset does not change any of the settings specified from the Config In/Out control panel or from the Tools menu, such
as GPIB address, Save/Export preferences, or the Auto Alignment setting.

Connecting a Signal

The spectrum analyzer has a single RF signal input located on the front panel. Make sure that you observe the input
signal requirements before connecting a signal to the input.

CAUTION. To prevent static damage to the instrument or to any instrument accessories, discharge to ground any
electrostatic charge that may be present on the center and outer conductors of cables, before attaching the cables to the
instrument inputs. Do not create an ESD (electrical static damage) antenna by leaving cables attached to the instrument with
the other ends of the cables open.
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Required Signal Levels

The following table shows the input signal levels over which the Real Time Spectrum Analyzer can be used for
measurements. The accuracy is guaranteed at a signal amplitude and frequency (normalization point). Measurements can
be made on signals within the entire range of allowable inputs, but the accuracy of the measurement is affected by the
frequency and amplitude of the signal to be measured (see the RSA6100A data sheet for more information).

RF Signal Input Range (CW or Peak Envelope Power)

Modulation Measurement Requirement Spectral Display Requirement
-50 dBm to +30 dBm DANL to +30 dBm

Input Signal Requirements

Characteristic Description
Input impedance 50 Q
Input frequency range
RSA6106A 9 kHz to 6.2 GHz
RSA6114A 9 kHz to 14 GHz
Maximum measurable continuous input power 1 W (+30 dBm)
Maximum voltage rating 140 V DC, AC coupled

CAUTION. To prevent damage to the instrument, do not connect CW signals greater than 1 Watt (+30 dBm). The maximum
voltage rating is 240 V DC. The maximum pulse specifications are 75 W peak, 10 us pulse width, 0.001 duty cycle, and
230 dB attenuation.

To connect an RF signal:

1. Connect the signal to the RF INPUT
connector on the front panel.

[enTenlenlenfan)
cooco OO
coococo O O

@
@u 1909015

Quick Tip

= [f the source signal is greater than 1 Watt (+30 dBm), connect the source signal to an attenuator. Connect the attenuator
output to the RF Input connector.
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Starting and Stopping Acquisitions

1. Click the Run button to start an

)\ Tek RSA6100A - [Spectrum]

vau|S|t|0n B Fle view Run Markers Setup Tools Window Help

Markers || Sellings || Triy || Ao | Arg © Frey: 1.48200 GHe

= Reflev: 0.00 o =l

While acquiring data, the button
label has green lettering.

2. Click the Run button again to stop
an acquisition. If an analysis is in
process, it will finish its sequence

[\ Tek RSAG100A
File Wiew Run Markers Setup Took ‘Window Help

®

EBX

and then stop. The button label
changes from green lettering to s
black lettering to indicate that the
instrument has stopped.

Quick Tip

m  Push the front panel Run button to start and stop acquisitions.

Run Control

m Markers ||Settings || Trig || Acg || Ana < Freq: 1.50000 GHz

% ReflLev: 0.00 dBm Rur I

©

The Run menu provides access to commands that control the acquisition and the measurement sequence. Refer to
the online help for information on all of the Run menu selections. Continuous is the default selection. When you select
Continuous, the instrument will continuously acquire data until you stop the acquisitions. Select Single Sequence to run a

single acquisition every time you click Run or push the Run button on the front panel.

Markers

Use markers to measure time, frequency, power and other results. Markers measure absolute values and can also measure

the difference between markers.

Using Markers to Measure Frequency and Power

The following procedure shows how to use markers in the Spectrum display to measure frequency and power. The example

assumes that all markers are turned off and that a signal is on the screen.

30

RSAB6100A Series Quick Start User Manual



1. Click Markers to open the
Marker toolbar at the bottom of
the Analysis window.

2. Select Add Marker from the
drop-down list on the Marker
Toolbar.

The first marker is designated
the marker reference (MR).

3. Position the marker on the
screen using the arrow buttons in
the Marker toolbar. You can also
drag the marker to the desired
position using the touch screen
or the mouse.

4. Read the frequency and power
level from the marker readout on
the display.

Behavior

]\ Tek RSA6100A - [Spectrum]
B Fle view Run Markers Setup Tools Window Help -8 x

[arkers ) © Freq: 148200GHz  © RefLev: 0.00 dom

1909-032

Marker:

Attach to:

I@ ML M2 M3 M4
dhisplay)

(in selected
Readouts; | Absalute B

Delete Marker
Markers Al markers off x
Analyzing  Acg BW: 5.00 MHz, Acg Length: 148.480 us Ref Int  Atten: 10 0B Preamp: On, max 3GHz
1909033

Real Tirne  Free Run

I\ Tek RSA61004 - [Spectrum]

BEE]
Bl Fle view Ru 4 Setup Taols Window Help -8 x

< Freq: 91.500 MHz ~ RefLev: -40.00 dBm
e v Trael [Mshow +Peak Normal

< -40.0 dBrm
© dBfdiv:
10.0de
Y REW
33 iz

-140 dB8m

Markers » MR Frequency |~ |ENS=NEH

Analyzing  Acg BW: 5.00 MHz, Acg Length: 148,450 us

© CF: 91,500 MHz

© Span: 3.810 MHz

feee) () ) 0 B (8 ) (1)

Ref Int  Atten: 10 4B Preamp: On, masx 3GHz
1909034

Real Time | Free Run

Operation

= Rectangular markers show absolute values in the readout. The readout of the selected marker appears in the upper left
corner of the display and in the Marker toolbar.

= Diamond markers show delta values (relative to the reference marker). The delta readout of the selected marker appears
in the upper right corner of the display and in the Marker toolbar.

®  When you drag markers along a trace with either the touch screen or the mouse, the marker will seek the high points.
The marker stays within 20 trace points of the mouse position. If there are no peaks within the current range of trace
points, the marker finds the highest point.

Quick Tips

= [f markers are turned off, click Peak in the Marker toolbar or on the front panel to add the marker reference (MR) and to
position it on the maximum peak level on the trace in the selected display.

®m  Click Table in the Marker toolbar to open a tabular display showing the marker information.

RSAB6100A Series Quick Start User Manual
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Marker Toolbar

The Marker toolbar has several controls to work with markers. (See Table 3.) Some of these controls are similar to those
on the front panel.

Table 3: Marker toolbar

Icon Description

Opens the Define Markers control panel. Use the control panel to add and
remove markers and to set marker parameters.

Sets the Measurement Frequency of the instrument to the frequency of the
selected marker. This button is only present when the selected display has
frequency on the horizontal axis.

Peak Moves the marker to the maximum peak level on the trace. The maximum peak
can be either the highest or the lowest point in displays with both positive and
negative values on their vertical axis (such as Frequency Error or Phase).

Defire

Ta Center

Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value refers to
the absolute value of the peak amplitude. When repeatedly moving the marker, it
can move in any direction depending on the location of the next peak.

Moves the selected marker to the next higher peak value. The peak value refers
to the absolute value of the peak amplitude. When repeatedly moving the marker,
it can move in any direction depending on the location of the next peak.

IHE]E]E]III

Table Opens or closes the marker table in the display.
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Adding Markers

You can have up to five markers. The first marker (MR) is a reference marker. The other markers (M1, M2, M3, and M4) can
show absolute values or can show both absolute values and the difference values between them and the reference marker.

To add another marker, select Add Marker from the drop-down list in the toolbar.

Defining Markers

Use the Define Markers control panel to define the marker settings.

1. Click Define to open the Define Markers | Markers [Dafine | v ML |Frecuency v [20M: +] [+ =] |

control panel. e
USG the COHtI’O' panel tO azfri;frs Marker Properties | Define Peaks

Reference Delta Markers
®  Add or delete markers. acd —— " " - . "
Attach to: Tracel ¥ Tracel %
B Turn markers off. Dneeaes
Readouts:  Delta -
®  Assign markers to specific traces. - o eoueny v]0M aioia) X
1909-03¢

®m  Set the marker readouts to absolute or

delta.

®  Define the threshold and excursion
values.

Quick Tip

B You can add or delete markers from the drop-down list next to Define in the Marker toolbar.
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Printing

You can print a copy of the screen and its contents (a screen shot) to a printer or a file.

Iﬂg Wiew Run  Markers

34

1. Push the Print button on the front panel
or select Print from the File menu.

2. Fill out the details in the Print dialog box,
and then click OK.

The Print dialog box is the standard
Microsoft Windows Print dialog box. The
printer controls are dependent on your
printer.

Recall,..
Save
Save As...

Chrl+s

Print Presview [§ @

Preset

Exit:

Print
Printer
Name:

Status: Ready

Comment:

Frint range

®al

() Selection

1909-017

Type: Microzoft Office Document Image ‘witer Diriver
‘Where:  Microsoft Document Imaging ‘Witer Port:

[ 1wl 1

[ Priett to file

Copies

Nurber of copies: 1 $

el

1909038
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Saving Data

You can save different types of data for future use.

Iau Wiew Run Markers

1. Select Save As. . . from the File menu

to open the Save As dialog box.

2. Navigate to the folder where you want
to save the setups, or use the default
location.

3. Enter a file name.

4. Select the type of file to save. (See
Table 4.)

5. Click Save.

Quick Tips

Operation

Recall...

Save Chrl+S @

Print... Chrl+P
Prink Presview

Preset
Exit
1909-039
2%
Savein: | ) RSAGT00A Fies v @ # @
|2)5ample Data Records
£ ;
My Fecent
Documents
?«%
Desktop
My Documents : : :
My Computer
Q i |Stabe Setup 10310 Setup v] S5va
>
MyNetwork  Saveastype:  |Setupfiles v ‘ [ cancel |

1909-040

m  Select File > Save or press the Save button to save the information to a file using the same name, path, and data type
as the last time that you saved. If the file already exists, the file name suffix number will increment if you previously
selected that option in the Tools > Options > Auto Filename control panel tab.

®m  Select File > Save As to open the standard Windows Save dialog box where you can edit the file name, choose what
data type to save, and select a folder for storing the file.
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Table 4: File Types for Save
File types

Description

Setup files

Saves all of the setup information for all settings displays, except those settings
that are specified under the Tools menu (Alignments and Options) or in the
Config In/Out control panel.

Results Export files

Saves the trace and numeric data for the selected display. The trace and numeric
data are saved in CSV format as text files.

Picture (PNG/JPG/BMP)

Saves a graphical representation of the screen in the specified format. This
option is useful for including the graphic in reports or other applications. Marker
readouts and other information are included.

Selected Trace

Saves a trace for later recall back into the display from which it was saved.

Data (acquisition data and acquisition

data export)

Saves data for reanalysis by the RSA6100A Series Real-Time Spectrum
Analyzers or as CSV (comma-separated value) data to use with external software.

Recalling Data

You can recall acquisition data and setup files previously saved by the RSA6100A Series Real-Time Spectrum Analyzers.

1. Push the Recall button on the front panel
or select Recall from the File menu.

2. In the Open dialog box, browse to the

location of the file.

'\.I'IEW Run Markers @
Save Ctri+3 é
Save s,

Prink... Ctri+P
Prink Preview

Presek

Exit

1909-041

Open @@
3. Ifyou do not see the file, select the type Looki: | £ ASASTO0A Fles ¥ o2 o
of file under Files of Type. D (S
My Recent
4. Double click the file name to load the file. D[ﬁl
Desktop
> @ @
My Documents
39
My Computer
‘,'] File name: v
My Ne‘lvfovk Files of type: Setup files v

36

1909-042
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Quick Tip

If you recall a trace that has an x-axis range that doesn't fall within the x-axis range of the current graph, the trace will not be
visible. A small arrow will point off-screen in the direction of the recalled trace. Use the Frequency and Span (or Span and
Offset) controls to bring the trace on the screen in the Spectrum display. In other displays, use Horizontal Scale and Offset
(which can also be used in the Spectrum display). These controls are on the Settings > Scale tab.

Advanced Techniques
Setting Up Triggering

The RSA6100A Series Real-Time Spectrum Analyzer offers real-time frequency domain triggering (option 02) in addition to
power-level triggers, line trigger, and external triggers. It uses a trigger event as a reference point in time for the seamless
acquisition of the signal. This allows the spectrum analyzer to store both pretrigger and post-trigger information.

The spectrum analyzer has two triggering modes:
Free Run mode. In Free run mode, the instrument initiates acquisitions without considering any trigger conditions. It

is a fast and easy way to see the signals. Free Run is usually adequate for the Spectrum display unless you need to
specify a particular time at which to collect the data record.

Triggered mode. In Triggered mode, the instrument initiates an acquisition when a trigger event is recognized. The
conditions that define a trigger event depend on the selected trigger source. There are several source selections available for
choosing the signal to monitor for a trigger event.

Once you select the Triggered mode, you must select the source. The trigger sources are:
B RF Input

m Trig In

B Trig2ln

m  Gated

B Line

Once you select the trigger source, you can set additional parameters to specify the trigger event. If you specify the RF Input
as the trigger source, you can chose from two trigger types:

Frequency Mask Triggering. Frequency Mask Triggering allows you to trigger the instrument when a signal in the
frequency domain violates the mask. You can draw a mask to define the conditions within the real-time bandwidth that will
generate the trigger event. It allows you to trigger on weak signals in the presence of strong signals. This triggering is
also useful for capturing intermittent signals.

Power Triggering. Power triggering triggers the instrument on time-domain signal characteristics. The incoming data is
compared to a user-selected level in dBm. You can select the time-domain bandwidth and trigger on the rising or falling edge.

In addition to defining the trigger event, you can define the following parameters by selecting the appropriate tab in
the Trigger control panel:

®  Time parameters that define where a trigger occurs within the acquired data record and whether to delay the trigger
for a set amount of time.

B An Advanced parameter that triggers each segment in swept acquisition mode.
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Accessing Trigger Parameters

1. Click Trig to open the Trigger control

I\ Tek RSA6100A - [Spectrum] E]@
g X

B Fie view Run Markers Setup Took Window Help

nel.
pa e msmtms Trig || Acg W “ Freq: 91.500 MHz

© RefLev: -40.00 dBm

2. As shown in the following steps, click
one of the tabs in the Trigger control
panel to define the trigger parameters.

Trigger

1909-043

@

'E;fEf’VV’friT\mE Advanced -
e |

3. Use the Event tab to set parameters that ©Frea fun S 1 ome e [0 |
define trigger events. The parameters S || S L
vary dependmg on the tngger Source B ¥ Time-domain BW: |1 MHe Bctual 6250k
and Type selections.
Analyzing  Acg BW: 5.00 MHz, Acg Length: 148,450 us Real Time  Free Run Ref Int  Atten: 10 4B Preamp: On, masx 3GHz
1909-044
4. Use the Time tab to set parameters that
control the position of the trigger event.
Trigger [Event | Time | advanced
®Free Run
Fosition: (25 % | Delay: 05 |
O Triggered
Location of trigger event within acquisition recard After trigger event, wait to act on it
Analyzing  Acg BW: 5.00 MHz, Acg Length: 148,450 us Real Time  Free Run Ref Int  Atten: 10 4B Preamp: On, masx 3GHz
1909-045
5. Use the Advanced tab to select whether
to trigger on each segment in Swept
acquisition mode. - e [0 )
rigger vent || Time Iv:
i
®Free Run
[ Trigger each segment in Swept acouisition mads
O Triggered {requires trigger signals across the entire Acguisition BW )
Analyzing  Acg BW: 5.00 MHz, Acg Length: 148.480 us Real Time  Free Run Ref: Int  Atten: 10 dB  Preamp: On, max 3GHz

Quick Tip
= Qther ways to access the Trigger control panel:
= Push the Trigger button on the front panel.

= Select Trigger . . . from the Setup menu.

38
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Creating a Frequency Mask

Operation

Use the Mask Editor to create a Frequency Mask. The mask is a set of points defined by frequency and amplitude. Access
the Mask Editor from the Trigger control panel. (This procedure uses the Spectrum display.)

1. Click Trig to open the Trigger control
panel.

Select the Event tab in the control panel.
Set the Source to RF Input.
Set the Type to Frequency Mask.

@ &~ w0 b

Click Mask Editor to open the Mask
Editor.

The Mask Editor opens with the traces of
the Spectrum display in the graph.

6. Click New in the tool bar. This removes

the existing mask and then creates a
default 6-point mask.

RSAB6100A Series Quick Start User Manual

T\ Tek RSA6100A - [Spectrum]
B Fie view Run Markers Setup Tooks Window Help

S

Markers |(settings|[ Trig |{ a0 J[ana | # Frem: 91.500 MHe

© RefLev: -40.00 dBm

@
@06

1909-043

®

Trigger | Event | Time | adinced
, Violation
ource: o
R Ot OTR RO 55T Mask Editor
RF Input v (out) (Out & In)
O Triggered e OF @F-T OF-T-F
Ha (in) {In & Out)
Freguency Mask & Tita ! Fake Load from fle...

Analyzing  Acg BW: 5.00 MHz, Acg Length: 148.450 us Real Time  Free Run

Ref Int  Atten: 10 B Preamp: On, max 3GHz

1909-047
@Qﬁmr - Mask1 =163
File
Hew I Open I Save ] Save As.‘.l [ Done
TR Gt points
-40.0 dBm
R ‘\,
I — .
I Ity | |ﬂ 0 Offset Freq Amplitude
‘ i |||‘ ”|| || ,“| i -2.500 MHz -70.00 dBm
o ||l wm \m,l “ o I\ o -1.000 MHz 70,00 dEm
0 ]
Il h“'fl [l Ml L‘,"’\jnH'nJ"l_ 500,000 kHz 50,00 dBm
l ' h ’ 500.000 kHz -50.00 dBm
140.0 dBm 1.000 MHz 70.00 dBm
CF! 91,500 MHz Span: 5,00 MHz e 370.00'GEm
1909-048
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7. Click any point in the mask to select it.
The frequency and amplitude of the

[ mask Editor - Mask1

File:

[]=1E3

Save As... | I Done:

selected point are highlighted in the Hew ] [ Cpen

graphl i O Add points
8. Edit the point by doing one of the TN © et pains

following: 40,0 cm

® Drag and drop the point with the
mouse.

B Enter the frequency and amplitude
in the table.

= Adjust amplitude with the up/down el
arrow keys and frequency with the

N

|

l|vrlr'||"\,l,all]IhJ'

CF: 91,500 MHz Span: 5.00 MHz

E
e« [»

Of et Freq Amplitude
2,500 MHz 70,00 dBm

-90.22 dBm
-50.00 dBm

500,000 kHz -50.00 dBm
1.000 MHz -70.00 dBm
2,500 MHz -70.00 dBm

left/right arrow keys.

Quick Tips

®m Right click on the display screen to add a new point.

®m (Click Add Points and then click on the graph to add a new point in the graph.

m  Click Next to select the next point in the graph.

= (Click the X (delete button) to delete the selected mask point.

m Click Save to save the mask file and continue working with the mask editor.

m  Click Open to load and edit a previously saved mask file.

1909-049
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Defining Trigger Conditions

Operation

After you have set up the mask, you can select whether to trigger on the presence or absence of mask violations.

1. Select a condition.

®

The choices are described below. (See Trigger [ Event Time | Advarced
Table 5.) The icons at the bottom of the . e viltian
control panel identify what is considered SRR ey 00 L eri
true or false. o= =R OF  eErT OnTr
Frequency Mask % Tite ! Fake

2. Click Triggered.

The instrument will trigger when the

trigger conditions are met.

Table 5: Trigger Violations

@q BW: 5.00 MHz, Acq Length: 148,480 us Real Time  Free Run Ref Int  Atten: 10 4B Preamp: On, masx 3GHz
1908-060

Violation Description

T The instrument triggers whenever the signal violates the mask (above the line).

F The instrument triggers whenever the signal has no points in the mask.

T>F One transition defines the trigger event. The signal must go out of the mask (no
violation) after being inside of the mask (violation).

F>T One transition defines the trigger event. The signal must go into the mask after
being outside of the mask.

T>F>T Two transitions define the trigger event. The signal must start inside of the mask,
cross outside of the mask, and then cross back into the mask.

F>T>F Two transitions define the trigger event. The signal must start outside of the mask

(no violation), cross into the mask, and then cross back outside of the mask.

RSAB6100A Series Quick Start User Manual
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Controlling Acquisitions

When two or more displays are open, one display controls the acquisition system. The acquisition requirements for the
selected display set the acquisition hardware parameters. While the acquisition parameters are optimized for the selected
display, they might not be ideal for other displays. In this case, the other displays might be unable to maintain optimum
performance and consequently might be unable to produce results. (This also happens when analyzing recalled data:
measurements attempt to deliver results, but may not be able to comply with all their settings.)

You can specify which display controls the hardware acquisition parameters by clicking anywhere in that display. When there
are multiple displays, the highlighted display controls the hardware acquisition parameters.

In this example, there are two displays, a 11 Tek RSA61004 AEE
. File Wiew Run Markers Setup Tools Window Help
(Sj.pe?trur?hdlsrﬁlam.aﬂf :tl::lp)é SpeCttrlrl]JmDPX | Displays | [arkers |[settings ][ Trg |[acq J[2na | @ Freq: 91.500 MHz o Reflev:-40.00dem [aml] [m
e e ot e i C sa
Spectrum display indicates that it is the S e ~ Bimap [Eshow On
selected display. At - Ee
. . < dB/div: = dBfdiv:
The check mark icon in the upper left corner i S0
. . . g “ RBW o REW
of the display indicates that acquisition B Bk
hardware is optimized for the DPX Spectrum
display.
\
u‘ ‘ ‘
"‘l“ i’mmw \Jlﬂ“ ‘i“ \||”‘ ‘”J lln"
-140 dBm -115 dBm | | L '
| (Autoscale | @ cR9LS00 M & spar: aslu mHz f [(Autoscale o CF: 01500 MHz o ap.
Markers v MR Frequency v |91.5 MHz E] E] E] @
Analyzing  Acg BW: 5.00 MHz, Acg Length: 148,450 us Real Time  Free Run Ref Int  Atten: 10 4B Preamp: On, masx 3GHz

1909-026

Some displays do not control the acquisition hardware. These displays just show the captured data. Some displays share
the same parameters. If any of one of these displays in such a family controls the acquisition hardware, then the acquisition
parameters are optimized for all of the displays in that family.
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Measurements with Conflicting Acquisition Requirements

The RSA6100A Series Real-Time Spectrum Analyzer lets you open any combination of measurements. You can select
the displays that you are interested in and the instrument will automatically set up the appropriate analysis and acquisition

parameters.

If measurements place conflicting requirements on the acquisition parameters, the current selected display takes priority. The
following example shows incompatible measurement settings when one display needs real-time data (such as the Amplitude
vs Time measurement) while another display requires swept data (such as a Spectrum graph with a very wide span).

1. Push the Preset button on the front
panel to set the instrument to the default
settings.

2. Tune the instrument to the frequency of
your signal and then set the span.

3. Click Displays to open the Select
Displays dialog box.

4. Select the General Signal Viewing folder.
5. Select the Amplitude vs Time icon.

6. Click Add to add the icon to the Selected
Displays list.

NOTE. Add the Spectrum display if it is not
already in the Selected Displays list.

7. Close the dialog box.

RSAB6100A Series Quick Start User Manual

Save

Touch Screen
U®

8
o

)\ Tek RSA6100A - [Spectrum]
B Fle view Run Markers Setup Tools Window Help g x

F)\su\avs Markers J[gettings |[ Trig [ aco [ #ra | = frea: 1.48200 GHe © RefLev: 0.00 dBm

1909-055

®

[ Select Displays 5 EE=X

Avalable displays:

[ Gen wing AMPL FREQ l_

GP Digital Modulation W hipi 1

Pulsed RE Arnplitude: ws DPs Frequency  Phasevs  RF IRQws  Spectrogramn
Time Spectrum ws Time Time Time

RF Measurernents
Time:

Querview

Spectrum

Selected displays:
= —
6 ‘

@ — —

1909-051
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8. Click Run to start acquiring data.

9. Increase the span in the Spectrum
display to 200 MHz.

Because Spectrum is the selected
display, the acquisition parameters
adjust automatically to meet the needs
of the display. The 200 MHz span
exceeds the real-time bandwidth of the
instrument. As a result, the instrument
will change to swept mode.

10. Look at the Status bar. The readout
“Swept” indicates when acquisitions are
swept.

When the acquisitions are in “Real Time,”

all measurements usually run. If the
acquisitions are swept, only the selected
display can run.

[\ Tek RSA6100A
File Wiew Run Markers Setup Tools Window Help

% RefLev: -40.00 dBm

[m

v Trace1 [Fshow  normal

& 40,0 dBm

< dBfdiv:
10.0 cB

@ Span:
110.0 MHz

-140 dBm

RMS: - dBm
Maz: - dBm

==
@ Scde: 2,220 us
Min: -- dBm ® -5

& Offset: 0,000 5
@ -5

|W WMarkers [|Settings || Trig || Acg || &na | & Freq: 1.9575 GHz

[\/Spectrum
<
< -40.0 dBm
= dBfdiv:
10.0de
“ RBW
e

v Trace1 [show  +Peak Normal

‘J ll ‘1.'“‘”““’\" Ml.l“ "'\ W

e Data acquired during

Autoscale

O CF: 1.9575 GHz Span: 200.0 MHz

Analyzing  Acg BW: 40,00 MHz, Acg Length: 4,440 us

Swept

Free Run Ref Int  Atten: 10 4B Preamp: /n, masx 3GHz

: 1909-052
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11. Click the Amplitude vs Time display to
make it the active display.

The acquisition switches back to
real-time because the selected display
requires real-time. The data is now
suitable for the Amplitude vs Time
display but doesn’t contain the full range
of frequencies needed by the Spectrum
display.

In this case, the Spectrum is unable to
run.

12. Decrease the span to 40 MHz in the
Spectrum display. Now the acquisitions

are real-time again.

13. Check the status bar readout to verify

that the acquisition is real-time.
Both of the displays can run now.

RSAB6100A Series Quick Start User Manual
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v Trace1 [Fshow  Normal

< -40.0 dBm

© dB/div:
10.0d8

 span:
110.0 MHz

-140 dBm

RMS:-50.62 dBm
Ma: -46.25 dBm

& Offset: 0,000 5
@ 193.3ns

© Scde: 667,000 ns
Min: 62,03 dBm @ 0.0000 5

% RefLev: -40.00 dBm

& -40.0 dBm

= dBfdiv:
100d8

o REW
e

-140 dBm

Autoscale

C ]|

v Trace1 [Fshow  +Peak Normal

CF: 1.9575 GHz & Span: 200.0 MHz

Analyzing  Acg BW: 110.00 MHz, Acq Length: 4.453 us

Real Time  Free Run

Ref Int  Atten: 10 4B Preamp: On, max 3GHz

I\ Tek RSA6100A
File Wiew Run Markers Setup Tools Window Help

1909-063

G

mplitude vs Time

g Trace 1

S -40.0 dBm

© dB/div:
10.0d8

¥ span:
40.00 MHz

-140 dBm

RMS:-49,33 dBm
Max: 45,75 dBm

& Offset: 0,000 5
@ 50.00ns

@ Scdle: 2.000 us
Min: -65.75 dBm @ 760.0ns

< Freq: 1.95752 GHz

% RefLev: -40.00 dBm

mn

& -40.0 dBm

= dBfdiv:
100d8

o REW
200 iz

-140 dBm

Autoscale

C ]|

v Trace1 [Fshow  +Peak Normal

‘ f\

I
{| || I |ﬂ

|'|H| |'\ | \ ﬂ"'“‘""‘" \“’

& CF: 105750 GHy

& Span: 40.00 MHz

Analyzing  Acg BW: 40,00 MHz, Acg Length: 14,880 us

Real Tirnegy Free Run

Ref Int  Atten: 10 4B Prear/a: On, masx 3GHz

®)
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Searching Signals

The RSA6100A Real-Time Spectrum Analyzer lets you search signals for changes in power level. You can identify matches
as crossing a power level or you can create a mask that specifies power level and frequency range limits. You can select
which trace to search and specify an action to take when a search match occurs.

To search a trace:

1. Open a Spectrum display or select the 1 Tok RSAG100A - Spoctrum] DE®
S ectrum dIS |a |f one |S alread open. B Fle view Run Merkers Setup Tools Window Help BEE
p p y y p Markars || Settings mmm © Freq: 1.49980 GHz “ RefLev: 0.00 dem
2. Select TOOlS > seaTCh. jnm . w Trace 1 [FShow  +Peak Normal B
= dB/div:
3. Select the Enable Search check box. i
 RBW
2901,in
-100.00 dBm
% CF: 1.49980 GHz © Span: 20.00 MHz
Search Define | Actions -
A EZ:E(I: Search in: | Spectrum: Trace 1 b
@ Search for: |is greater than - -20.00 dBm

1908-134

4. Select the trace you wish to search from
the Search in drop-down list box.

. Tek RSA6100A - [Bpectrum] EEX
. . ﬂﬁl Run Mjrkers Setup Tools Window Help -8 %
5. Verify that the trace you selected in the = CEmomer | o amar
Search in list is the selected trace and v S e e
that the Show box is checked. * 000 cam
< da/div:
10.0 dB
<~ RBW
200 kHz
-100.00 dBm
= CF:1.49980 GHz © Span: 20.00 MHz
Search Define | Actions
O gz:?:‘i Search in: |Spectrum: Trace 1 R
Sectrum Trace 1
Spectrum: Math Trace
Spectrum: Spectrogram T |ice

1908-120
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6. Specify what to search for by making a 1. Tek RSAG100A - [Spectrum] oEx
| | nfr m h r hf rdr _ wn lee View Run Markers Setup Tools Window Help _ 8 x
ls.eteCtO om the Search for d op do Warkers | [settings [ Trig | Acq [ Ana | © Freq: 1.49980 GHz © RefLev: 0.00 dBm
ISt. < « Trace 1 [ZIShow  +Peak Normal r
To search for signal levels above or - INGED
e . . < da/div:
below a specified level, select either is 10048
greater than or is less than. .
To search for signal levels that vary with
frequency, select either is outside mask
or is inside mask. To specify the limits
in the search mask, click the Edit limits
-100.00 dBm
button. = CF: 1.49980 GHz © Span: 20.00 MHz
T_he orange shaded area in t.he glraph Search efie | actons
display shows the levels which, if .
occupied by the signal, will constitute a ¥ searcn el specnim T 1 x
matCh Search for: |is greater than - -20.00 dBm
’ is greater than
is less than
is outside mask

inside mask
@ 1908121

Display with greater than search selected

UL Tek RSA6100A - [Spectrum] []=1]E3]
[1ES \ Run Markers Setup Tools N Help -8 x
Markers | (Settings ][ Trig [ Aca ][ 4na | = Frea: 1.49980 6Hz © Reflev: 0.00 dBm
v “# Trace1 [“IShow  +Peak Normal r
< 0.00 dBm

 da/div:

10.0 dB

“ RBW

200 kriz

-100.00 dBm
¥ CF: 1.49980 GHz ¥ Span: 20.00 MHz
Search Define | Actions .

Enable

Search Search in: | Spectrum: Trace 1 v

Search for: |is outside mask v __Edn: lirvits....

Display with outside mask search selected
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7. Click the Actions tab to specify what 1 Tok RSAS100A - [Spectrum] EEX
actions the spectrum analyzer should W eRvevErm i mﬁl‘ﬁdﬁ‘ » : Sl
take When a match OCCurS J-_lsp\ays rvva.rier;::t;lngs;rf” Ac: k.-:va ‘4 Freq: 1.49980 GHz @ RefLev: 0.00 dBm -Rep\ay -.m
The spectrum analyzer can take up 0,00 dhm
to five actions when a match occurs, oo
depending on the run mode. In Run * ot
mode, the spectrum analyzer can
sound a beep, stop acquisitions, save
acquisition data, save trace data, and
save a picture of the display. In Replay

H -100.00 dBm
mOde' llt Can Sound a beep and Stop _\lnutzsuczleﬁ & CF: 1.49980 GHz & Span: 20.00 MHz
analyzing. Search Defna] A

8. To have the spectrum analyzer take an mEne SRR R
action when a match occurs, select the o i
desired action. it @
You can select any combination of @ e
actions to perform on a match. If you
select all actions, they will all occur when
a match is found (in Run mode).

9. Click the close box to remove the Search
control panel.

"\ Tek RSA6100A - [Spectrum] [=1]ES]
C ey B Fle view Run Markers Setp Took Vndow Help r==\==F 5

10' Press the RUN bUtton to Inltlate a ‘ Markers ||Settings [Tg"mm ~ Freq: 1.49980 GHz © Reflev: 0.00 dBm : Replay | Run 1
SearCh- v # Trace1 [“JShow  +Peak Normal =) J
Red lines appear in the graph display -
when there is a match on incoming data. o
Click the Replay button on the toolbar A
to initiate a search on the current data
record.

-100.00 dBm
S CF: 1.49980 GHz & Span: 20.00 MHz

1908-136
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Using Correction Tables

Operation

The RSA6100A Real-Time Spectrum Analyzer lets correct the signal displays and measurement results to account for gain
or losses in external equipment. You can specify a single gain value or you can use an external loss table to adjust the

gain/loss value based on frequency.

To specify external gain/loss corrections:

1. Press the Ampl button to display the
Amplitude control panel.

2. Select the External Gain/Loss Correction
tab.

3. To apply a constant correction factor,
select the External Gain value check
box. Enter a value into the text entry box.

NOTE. You can enter either positive or
negative gain values. Positive values
represent a gain. Negative values represent
a loss.

4. To use a table that corrects for gain/loss
values depending on frequency, click a
check box under External Loss Tables.
You can enable all three external loss
tables at the same time. Thus, you could
use different external loss tables for an
antenna, a preamplifier, and for cabling.

5. To edit the contents of an external loss
table, click the Edit button for the table
you want to edit.

RSAB6100A Series Quick Start User Manual

71 Tek RSA6100A - [Spectrum]

EEX

B Fie view Run Markers Setup Tools Window Help BEE
7 Trace 2 [Jshow Off ar
2 0.00 dBm
= dB/div
10.0 d8
“ RBW
200 Ktz
-100.00 dBm
© CF: 1.49980 GHz o Span: 20.00 MHz
Amplitude Internal Settings | External Gain/Loss Correction | External Probe Correction
External Loss Tables (Loss > 0, Gain < 0)
[ External Gain value: 0O
1909130
Amplitude Intemnal Settings | External Gain/Loss Corraction | Exteral Prabe Correction
External Loss Tables (Loss > 0, Gain < 0)
[] External Gain value: |10.0 dB O
o
@ 1909-122
Amplitude Internal Sattings | External Gain/Loss Correction | External Probe Correction
Extemal Loss Tables (Loss > 0, Gain < 0)
[ external Gain value: [7] |Ext Loss Table 1 [ edit. @
O
@ o @
1909-123
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6. Edit the contents of the table to match
the loss characteristics of the equipment
you are correcting for. Click OK when
you are finished.

NOTE. You can enter either positive or
negative values into the table. But in contrast
to the External Gain value setting, positive
values represent a loss and negative values
represent a gain.

For detailed information on using the Table
Editor, select Help > User Manual and look
in the Index for External Loss Tables.

7. You can change the title for each external
loss table. Select the title box and type
in a new title.

Note that the title is only a label. It is not
tied to the file name of any table you may
have loaded or saved.

8. Click the close box to remove the

Amplitude control panel when you are
finished making changes.

Table Editor - Ext Loss Table 1

X: Frequency Y: Loss (Atten)
5.500000 GHz -1.023000 dB
£.000000 GHz -1.050000 dB

Add Point

Hew Table

(=] (=]

(=]

I Tek RSA6100A - [Spectrum]

Run Markers Setup Tools Window Help -8 %
Markers || Settings || Trig || Acg J| Ana | ¥ Freg: 1.49980 GHz % ReflLev: 0.00 dBm
« Trace 2 [JShow Off
© 0.00 dBm
© da/div:
10.0 dB
= RBW
200 kriz
-100.00 dBm
S CF:1.49980 GHz 2 Span: 20.00 MHz
Amplitude Internal Settings | External Gain/Loss Correction | External Probe Correction
External Loss Tables (Loss > 0, Gain < 0)
[Extemal Gain value: Antenna
praag
@ % [coond

1908-124
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Using Audio Demodulation

Operation

The RSA6100A Real-Time Spectrum Analyzer can demodulate audio signals which can help you to identify unknown radio
signals. You access the Audio Demod tab from the Settings control panel of the DPX Spectrum display.

To demodulate an audio signal:

1. Press the Displays button to display the
Select Displays dialog box.

2. Select the General Signal Viewing
folder.

3. Double-click the DPX Spectrum icon to
add it to the Selected Displays list.

4. Click OK to close the dialog box. The
DPX Spectrum display will open.

5. Press the Settings front-panel button
to display the DPX Spectrum Settings
control panel.

6. Click the Audio Demod tab to display
the Audio Demod control panel.

RSAB6100A Series Quick Start User Manual

Select Displays 9 0

Folders: Avaiable displays:
General Signal Viewing AMPL FREQ
GP Digital Modulation — po Y -H»
RF Measurements
pulsed RE Amplitude vs DPX Frequency  Phasevs  RFIRQvs Spectrogram
Time Spectrum vs Time Time Time
Time
Overview

Selected displays:

Spectrum

oo ]

@ 1908-125

) Tek RSA6100A - [DPX Spectrum] EEX
Bl Fie view Run Markers Setup Tools Window Help _ 8 x
Markers || Settings || Trig || Acg [| Ana | ¥ Freq: 1.49980 GHz ¢ ReflLev: 0.00 dBm
v +Peak [“Show  +Pk Normal

© 0.00 dBm
& dB/div:
10.0 dB
© RBW
200 kHz
-100.00 dBm
© CF:1.49980 GHz
DPX Spectrum | Freq & Span | BW | Traces | Scale | Prefs | Audio Demod
Settings R —
n
Audio
Gain™
off FM
L)
Restore
Defaults

* Sound level is also affected by Windows volume control.

© Span: 20.00 MHz

Tune with: | Selected Marker v |

Receiver Freq: 1.49980 GHz

Receiver Bw; |30-000 kHz |

1909126
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7. Click the On button to enable audio
demodulation.

8. To specify the demodulation type, click
either the AM or FM button.

NOTE. Note that the AM and FM buttons
select only the demodulation type; they do
not specify a frequency band.

9. Set the center frequency as needed.

The receiver frequency (frequency to
be demodulated) is specified with either
markers or the frequency control (the
front panel Frequency button or the Freq
control in the toolbar). Use the Tune with
setting to specify whether markers or the
frequency control is used to specify the
receiver frequency.

10. Select either a marker or frequency
control from the Tune with drop-down
list.

11. If the marker you select is not enabled
(it will be visible in the display if it is
enabled), click the Markers button in the
toolbar to display the Markers toolbar.

@

DPX Spectrum | Freq & 5p|n | BW | Traces|| Scale | Prefs | Audio Demod
Settings
Tune with: | Selected Marker ¥
o
Audio Receiver Freq: 1.49980 GHz
Gain®
of m Receiver Bw: |30:000 kHz
L>
Restore
Defaults *Sound evel is also affected by Windows volume contral.

1909127

)

DPX Spectrum | Freq & Span | BW | Traces|| Scale | Prefs \ AudioDemod |  _ _ _ _ _ _ _ _ _ — — _—
Settings |

] Tune with:
on | | [ A | ]
Audio Receiver Freq: M
Gain* - Marker M2
Of M . |Marker M3
Receiver BW: o0 ot s

Selacted Marker

Restore ‘T>
Defaults * Sound level is also affected by Windows v{Freq control |

1908129

)\ Tek RSA6100A - [DPX Spectrum] (=3

Bl Fie View Run Merkers Setup Tooks Window Help B
‘ warkers || Settings || Tria || Acq || Ana | @ Freq: 1.49980 6Hz < Reflev: 0.00 dBm :Ii i
~ +Peak [FShow  +Pk Normal Ch

© 0.00 dBm
© dB/div:

10.0 dB
o RBW

200 kHz

-100.00 dBm
o CF: 1.49980 GHz © Span: 20.00 MHz
DPX Spectrum | Freq & Span | BW | Traces | Scale | Prefs | Audio Demod

Settings

Tune with: |Selected Marker
Audio Receiver Freq: 1.49980 GHz
Gain™
off M a0 z
Receiver Bw: |30-000 kHz
>
Restore
Defaults * Sound level is also affected by Windows velume control.
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12. Click the Define button in the Marker
toolbar to display the Define Markers
control panel.

13. Click Add to add markers as needed.

14. Click the Settings button to return to the
Audio Demod control panel.
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Define WMarker Properties | Defina Peaks
Marker
Reference Delta Markers
cd Marker: MR 1 M2 M3 ]
Attach to: +Pesk v
Delete (in selected
display)
Readouts: | Absolute 5
All Off

Markers | Define | «» MR

T Tek RSA6100A - [DPX [ppectrum]

B Fie view Run Markers| Setup Tools Window Help

Frequency ¥ |1.4958 GHz

[reere] (7o) (€ () &) [(8) ) (3

1900-128

~ Freq: 1.49980 GHz

 +Peak [FShow  +Pk Normal

% 0.00 dBm
© dBfdiv:
10.0 dB
~ RBW
200 ktiz
-100.00 dBm
© CF: 1.49980 GHz
Define Marker Properties | pefine Peaks
Markers -
Reference Dela Markers
Marker: MR M1 M2 M3 M4
Attach to: +Peak v
(in selected
display)
Readouts: | Absolute v

Markers ~ MR

Frequency |+ |1.4998 GHz

) o) (5 () ) (8) () (1

1909131
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15. Set the required receiver bandwidth by
entering a value into the Receiver BW
value entry box.

16. Set the receiver frequency.

If you specified a marker with the Tune
with setting, drag the marker to the
required frequency. If you selected
Frequency control in the Tune with
setting, press the front-panel FREQ
button, then turn the front-panel knob or
use the Freq setting in the toolbar to set
the required frequency.

The receiver frequency is displayed as
Receiver Freq between the Tune with
and Receiver BW settings.

17. Adjust the Audio Gain setting so you can
hear the demodulated signal. Note that
the sound level is also affected by the
setting of the Windows volume control.

DPX Spectrum | Freq & Span | BW | Traces | Scale | Prefs | Audio Demod
Settings
Tune with: | Marker MR v
Audio Receiver Freq: 1.4958 GHz
Gain®
off i Receiver Bw: | 30000 kHz
L
Restore
Defaults * Sound level is also affected by Windows volume ¢ | ntrol.
wrkrs v [ Wi DEEEED T

1908132

I Tek RSA6100A - [DPX Spectrum] Q@@

Bl Fle view Run Merkers Sewp Tools BEEES
© Freq: 1.49980 GHz © RefLev: 0.00 dBm
-

+Pk Normal
& 0.00 dBm

= dB/div:
10.0 dB

~ RBW
200 ktiz

-100.00 dBm

© CF: 1.49980 GHz ' Span: 20.00 MHz

DPX Spectrum | Freq & Span | BW | Traces @

Settings
on
Audio ’
Gain™®
i Receiver Bw: |30-000 kHz
Restare
Defaults * Sound level is also affected by Windows volume control.

[y S[1ma olo

Tune with: |Marker MR W]

Receiver Freq: 1.4958 GHz

1900-133
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Applications

This section provides examples of typical applications using the spectrum analyzer. Each example requires that the
instrument to be powered on and connected to a signal. Your signals might be different from the ones shown in the examples.
As a result, you need to modify the instrument settings to view your signal.

NOTE. Some of the examples are based on saved acquisition data files. The setup files are located in the C:\RSA6100A
Files\Sample Data Records folder. You can load these files from the File > Recall menu to step through the following
applications.

Modulation Analysis

The RSA6100A Real-Time Spectrum Analyzer lets you analyze signals in many different ways without needing to reacquire
the signal. The following example shows how to use the RSA6100A Real-Time Spectrum Analyzer, with Option 21
installed, to demodulate a QPSK signal and to analyze the signal in multiple domains. This example shows you how to use
the instrument to do the following:

B Demodulate a QPSK signal to show its constellation diagram.
= Measure the EVM (Error Vector Magnitude) and other key indicators using the Signal Quality display.
m View the phase of the signal in the time domain.

m  Use markers to show the correlation of results across the Symbol Table display, Constellation display, and the Phase vs
Time display.

NOTE. The following examples were based on the QPSK sample data file. If desired, you can load the QPSK sample data
file (the file name is QPSKDemo.tiq) to recreate the steps used in this application. The signal settings in the following
examples were based on the signal in the sample file. If you use a live signal, your settings may differ.
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Demodulate the Signal

1. Push the Preset button on the front
panel to set the instrument to the default
settings.

2. Tune the instrument to 2.13 GHz and set
the span to 20 MHz.

3. Click Displays to open the Select
Displays dialog box.

4. Select the General Signal Viewing folder.
5. Select the Time Overview icon.

6. Click Add to add the Time Overview icon
to the Selected Displays list.

7. Select the GP Digital Modulation folder.
8. Select the Signal Quality icon.

9. Click Add to add the icon to the Selected
Displays list.

10. Repeat steps 8 and 9 for the Constellation
icon, and then close the dialog box.

56

"\ Tek RSA61004 - [Spectrum]

B Fle view Run Markers Setup Tools Window Help x
’—E)\su\avs Markers J[gettings | Trig [ aco [ 2ra | = frea: 1.48200 GHe © RefLev: 0.00 dBm
1909085

[ Select Displays 5 EE=X

Avalable displays:

i 2|
RF MeasLrements " ==
Pulsed RE Arnplitude: ws DPs Frequency  Phasevs  RF IRQws  Spectrogramn
Time Spectrum ws Time Time Ti
Time @
Querview

Selected displays:

Spectrum
= et | [5]%)
ct Dl -]
Folders: Avalable displays:
General Signal Wiswing EV
GP Digital Modulation E @
RF Measuremnents )
Pulsed RE Constellation EVM ws Time Mag Errar vs Phase Error g Signal Syrmbol
I; @ ime s Time-" Quality Table
Selected displays:
|
Spectrum Time
Overview
Rern
1909057
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The General Purpose Digital Demodulation displays share the same modulation and advanced parameter controls. These
controls are available in the Settings control panel of each display.

11. Select the Signal Quality display and
then click Settings.

12.
13.
14,

Select the Modulation tab.
Set the Modulation Type to QPSK.
Set the Symbol Rate to 3.84 MHz.

15. Set the Measurement Filter to

RootRaisedCosine.

16. Set the Reference Filter to

RaisedCosine.
17.
18.

Set the Filter Parameter to 0.220.

Close the control panel.

Analyze the Signal

)\ Tek RSA6100A - [Spectrum]

B Fle view Run Markers Setup Tools Window Help -8 x
Markers J[gettings | Trig [ aco [ #ra | = frea: 1.48200 GHe © RefLev: 0.00 dBm
1909058

®@

Constellation ‘Mndu\amn Advanced Params | Find | Analysis

Settings
Modiulation type: | QPSK &

@ Symbol Rate: |5.00 MHz

Standard
Settings...

)/1—3\9 Prefs
UEasuremethMter: RootRaisedCosine %
Reference Filter:

m Filter Parameter: 0.220

Run Acg BW: 10.24 MHz, Acq Length: 66.562 Us

Real Time Free Run

Ref: Int | Atten: 20 dB8

1909-059

—

5

Constellation | Modulation | Advanced Params | Find | Analysis

S~
Time | Trace 7T\

Settings

Mockistin type:
Symbol Rate: (5,00 MHz

Standard
Settings...

16
MeUFMtev: RootRaisedCosine v

Reference Filker: | RaisedCosine - @
Filter Pararneter: |0.220

Run Acg BW: 10.24 MHz, Acq Length: 66.562 us

Real Time Free Run

You can analyze the signal using both qualitative and quantitative methods.

The Constellation display should look similar
to the illustration. For a QPSK signal, the

points should be located in four tight clusters.

If not, check your settings for Frequency,

)\ Tek RSAG100A
File Wiew Run Markers Setup Tools ‘Window Help

Ref: Int | Atten: 20 dB { 17\

1909-060

A

Markers ||Settings || Trig || Acg || Ana < Freq: 1.48220 GHz

% ReflLev: 0.00 dBm

e 'u‘Ellin[!ﬂ‘ me G

Modulation Type, Symbol Rate, and Filters.

Look at the information in the Signal Quality
display. It may be easier to read the
information if you stop the acquisitions by
clicking Run. The Signal Quality display
shows the EVM in both percentages and dB
units. There are EVM readings for RMS and
Peak. The final result in the EVM results
readout area is the time at which the peak
EVM occurred.
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)\ Constellation

< RS Peak Location
EWM:  15.059 % 27.385 % 117,00 Sym
-16.444 dB -11.250 dB
Phase Error: 6,567 15.396 © 34.00 Sym
Mag Errar: 9.772 % 23.346 % 111.00 Sym
IQ Origin Offset: -35.260d8  Frequency Error:  4.200 MHz
Gaih Imbalance:  0.409 dB Quadrature Error: -0.289 °
Rho:  0.988755

‘Ana\ys\s Length » IZiﬁZEus Actual: 25.625 us

¥ 0.00 dBm
W? M &l
< dB/div: l“l .
10.00 de
-100.00 dem
+
< Offset: 0.000 s o Scale: 66.562 us

“ 0,00 dBrn

v Trare 1 [“]show  +Peak Normal

Marker
e 2 cBfdv:
Mag: 10,00 dg
Phase:
“ RBW
Symbal:
Walue: Sl
5 e [PPSO !fcasurement is multi-acq but not primary
EvMPeaki 27.385% @ 117.00Sym RMS: 15.059 % Autoscale © CF:1.48220 GHz © Span: 40.00 MHz
Run Acg BW: 10.24 MHe, Acq Length: 66.562 us Real Time Free Run Ref: Int | Atten: 20 dB
1909061
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Manually Adjust the Analysis Length

The Time Overview display shows the entire acquisition record, illustrating the length and offset for Spectrum Time and
Analysis Time. The spectrum length is the period of time within the acquisition record for which the spectrum is calculated.
The analysis length is the period of time within the acquisition record where other measurements are made. The analysis
length can be automatically determined by the symbol rate, or you can manually increase the analysis length.

1. In the Time Overview display, select
Analysis Length. (Check that
acquisitions are running by verifying that
the RUN button is lit.)

2. Click the Analysis Length value once to
select the Analysis Length control.

The analysis length is indicated by the
blue bar above the graph.

3. Increase the analysis length.

Changing the Analysis Length setting
changes the amount of data used by
the demodulation displays in computing
their measurements. The shading in the
display shows the extent of the analysis
period.

The increased analysis length causes
the instrument to automatically increase
the acquisition length setting to collect
enough samples to satisfy the new
analysis settings. By default, the
automatically determined Acquisition
Length is twice the Analysis Length.

4. Select Analysis Offset.

T\ Time Overview

|ﬂ\nalvsis Length  » |28.DDD s TActuaI: 28.000 us

A

-36.00 dém

-

+
o Offset: 0,000 s  Scale: 68,984 us

1909-062

I\ Time Overview

|ﬂ\nalvsis Length % |95.000 us —|Actual: 95,000 us

& 0.00 dBm

< dBfdiv
3.60 dB

-36.00 dem

T
o Offset: 0,000 5 & Scale: 190,000 s

1909-063

I\ Time Overview

‘Analysis Length » 95.@\4'/ |Actua|: 95,000 us

Analysis Offset \

Spectrum Length
Spectrum Offset
A=lENs|

-36.00 dBm

s
5 Offset: 0,000 5  Scale: 190,000 s

1909-064
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5. Increase the Analysis Offset setting.

If the analysis offset is increased such
that the analysis period extends past
the end of the acquisition record, the
instrument automatically increases
the acquisition length to provide the
additional data.

6. Change the Analysis Offset setting to
20ps.

7. Click Run to stop the acquisitions.

8. Increase the analysis offset again.

Because the instrument is stopped, it
can’'t run a new acquisition to capture a
longer data record. When the requested
analysis period extends past the end

of the data record, the actual analysis
length is reduced.
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I\ Time Overview

|ﬂ\nalvsis Offsat w |65.000 us —|

& 0.00 dBm

< dBfdiv
3.60 dB

-36.00 dem

-

+
v Offset: 0,000 5

© Scale: 100,000 us
1909-065

m

1220 GHz © RefLev: 0.00 dBm Run

I\ Time Overview E I:I][ZJ

[Bralysis Offset v (2000005 © |

% 0.00 dBrm

< dBfdiv:
3.60dB

-36.00 dBm

£
& Offset: 0,000 5

& Scaler 190,000 us
1909-066

T\ Time Overview

|Analysis Offsat v |SD.DDD L5

& 0.00 dBm

o dB/fdiv:
3.60 dB

-36.00 dBm

*
© Offset: 0,000 5

© Scale: 190,000 us

1909-067
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Capturing Transient Signals

60

The RSA6100A Series Spectrum Analyzer can identify infrequently-occurring transient signals and low-power signals that
may be obscured by stronger signals. After you find that these signals exist, you can use some of the following tools to
capture and examine the signal details to determine the cause:

B Use the Max Hold function to verify the presence of signals other than the CW signal.
®m  Use the DPX Spectrum display to view transient signals.
B Create a frequency mask and the use the Frequency Mask trigger to capture any signal that violates the mask.

B Use the Spectrogram with Frequency Mask Trigger to view the mask violations in the Time and Frequency domains.

Viewing Transient Signals in the Spectrum Analyzer Display

For traditional spectrum analyzers to show an accurate representation of a signal, the signal must be present and stable
during the entire sweep (capture time). However, some transient signals can cause interference so infrequently that they
might seem impossible to detect and capture with traditional spectrum analyzers. The RSA6100A Series Spectrum Analyzer
has several tools to help you see these transient signals.

NOTE. To complete these examples, you will need a signal with transients. A free source of transient signals can be found
by looking at off-air signals of radio transmitters using a simple antenna on the input of a spectrum analyzer. The cellular and
ISM (Industrial, Scientific, Medical) bands contain many signals. The ISM band is at 2.45 GHz for most countries.

1. Push the Preset button on the front
panel to set the instrument to the
default settings.

Touch Screen
Preset J J @

2. Tune the instrument to the desired . Tek RSA61004 - [Spectrum]

fre uenc and adust the span to V|eW Bl Fie view Run Markers Setup Tadls Window Help N
theqsigna}ll on the JSCI'een P Markers |(Settings [ Trig | aca | &na ] © Frea: 1.48200 GHe © RefLev: 0.00 dBm

3. Click Settings. @
4, Select the Traces tab. @

5. Make sure that Trace 1 is selected - e __
. pectrum teq & Span races |srale | Pref
and that Show is selected. Settings
Trace: |Trace 1 ~ [Fshow CFreszs
[-]

6. SeleCt +Peak' @ Detection: | +Peak i @
r
7. Select Max HOId @ Function: |Max Hold %
Max H0|d iS the maximum amp”tude Run Acg BW: 20.48 MHz, &cq Length: 14,844 us Swept  Free Run Ref: Int | Atten: 20 dB

for the frequency data point across all
included traces.

1909-076

8. Close the control panel.
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Over time, if a transient signal occurs, the Max Hold trace will show its presence.

Detecting Transient Signals Using the DPX Spectrum Display

The DPX Spectrum display uses a bitmap image in addition to line traces to view signals. Bitmaps can represent multi-value
signals so that you can see low-level and higher power signals that occur at the same frequency, but at different times.

1. Push the Preset button on the front

panel to set the instrument to the

default settings. Save

Touch Screen

U®

2. Click Displays. I\ Tek RSA6100A - [Spectrum] CEx

B Fle view Run Markers Setup Tools Window Help

F)\su\avs Markers J[gettings | Trig [ aco [ 2ra | = frea: 1.48200 GHe © RefLev: 0.00 dBm

1909-077

3. Select the General Signal Viewing P — AEE)

f0|der' Folders: Avallable displays:

) Gene! 0 . ' a 7'

4' SeleCt the DPX SpeCtrum icon. gz‘iia;%rements AmpTIitude ¥s Freq;lent\/ DhTase v RFTI&Q ¥s  Spectrogram
5. Click Add to add the application to the @

Selected Displays list. Time

Overview
Selected displays:
@ ) add
Spectrum

1909078
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6. Select the Spectrum icon in the
Selected Displays list.

7. Click Remove to clear the icon from
the list.

8. Close the dialog box.

9. Tune the instrument to the signal.

10. Adjust the span.

11. Select Enable +Peak Trace from the
drop down menu. This new trace
detects the highest peaks in each DPX
frame.

12. Click Settings to open the DPX
Spectrum Settings control panel.

13. Select Hold from the Function list to
hold the peaks from all acquisitions.

14. Close the control panel.

Quick Tip

[ Select Displays

EEX
0 I

RF [&0Q ws  Spectrogram Time
T Overvigw

Folders: : Avalable displays:

AMPL FREG RF G
i - At

Amplitude vs  Frequency Phase vs
Time vs Time Time

RF Measurernents
Pulsed RF

Selected displays:

™R

DRX
Spectrum

@ Remaove

@ —

1909-079

I\ Tek RSA61004A - [DPX Sgecirum] QE‘
a8 x

B Fle view Run Markers/Setup Tools Window Help -

Eemnqs < Freq: 91.40 MHz < ReflLev: 0.00 dBm
11 ~ Aitman  VIShow  On

 dBfdiv: Enatle -Peak
8.00 dB Enable Average

= REW Enable Math
100 ke

DPX Spectrum | Freq & Span | BW Tla(ES‘Scale Prefs
Settings %]
spok Traco Mehow  [lFreee
Detection:  +Pk
-
Restore ey 2
st Functon: | TEEI ~ | @ [-]
v e ]

1909081

= (Click Clear located just above the graph to clear the display and start collecting points again.
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The Max Hold function shows the highest points collected over continuing updates. While the +Peak Trace shows the
highest points, it doesn’t show signals that are below the maximum value at any frequency. However, this is possible

with the DPX bitmap trace.

15. Select Bitmap from the Trace Selector.

16. Click Settings to open the DPX
Spectrum Settings control panel.

17. Click Dot Persistence.

18. Increase the Persistence time.

The more you increase the Persistence
setting and the Intensity setting, the more
quickly you will see infrequent signal events.
In this example, the more frequent signals
appear in red; infrequent signals will appear
in blue.

These settings can also be used to display
signals below the maximum signal level. For
example, a low-level signal in the presence
of a pulsed signal might require a lower
Persistence and Intensity setting.
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Frequency Mask Triggering

If your instrument has Option 05 installed, you can use the Mask Editor to create a frequency mask for triggering on transient
signals. Complete the following steps to get a good visual reference that you can use to build the frequency mask.

Push the Preset button on the front
panel to set the instrument to the default
settings.

Touch Screen
Off Preset J J @

1909-016
Tune the instrument to the frequency of 0 e
your Slgnal' L Tek RSAG100A - [Spectriy [AEE
. Bl Fle view Run Markers Jetup Tools Window Help - a
Adjust the span. m (ks | [stongs T J e JL o | © Feem 195752642 © Reftev: -40.00 dem
“ Trace 1 [#IShow  +Peak Normal ar
Click Settings to open the Settings © 400 cem
control panel. yeed
 RBW
300k
-140 dB8m
o CF: 1.95752 GHz © Span: 40.00 MHz
Analyzing  Acg BW: 40,00 MHz, Acg Length: 14,880 us Real Time  Free Run Ref Int  Atten: 1048 Preamp: Off
1909-085
Select the Traces tab. 1 TekRSA100A - [Specirum] =]
Bl Fle view Run Markers Setup Tools Window Help RS
Select Trace 1 (make sure the ShOW Displays MME < Freq: 1.95752 GHz % RefLev: -40.00 dBm Run
CheCk bOX |S ChECked). .  Trace 1 how  +Peak Max Hold
. < dBfdiv:
Set the Detection to +Peak. i
_ =
Set the Function to Max Hold.
Close the control panel.
-140 dBm
Autoscale © CF: 1.95752 GHz © Span; 40.00 MHz
Spectrum Freq & Span | Bw | Traces |Scale | Prefs,
Settings

Trace: [Tace1 v @ Elen Orez

: v
Detection: |+Peak @ I™ Show recaled trace @
Function: | [EETEE(-NIN ~ sl

Restore 3 lay Hold u
Defaults 8
Analyzing  Acg BW: 40,00 MHz, Acg Length: 14,880 us it Free Run Ref Int  Atten: 1048 Preamp: Off

1909086
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10. Click Trig to open the Trigger control
panel.

11. Set the Type to Frequency Mask.

12. Click Mask Editor to open the Mask
Editor.

13. Use the Mask Editor to create a mask for
your signal. (See page 39, Creating a
Frequency Mask.)

Traces that you selected in the Spectrum
Analyzer display are used as references
in the Mask Editor. All trace detections
and functions are available.

14. Close the Mask Editor.

15. Select the condition that you are
interested in.

For example, if you want the instrument
to trigger when it detects the first violation
after seeing at least one acquisition with
no violations, select the F > T violation.
(A violation is when any point is within
the shaded mask line.)

16. Click Triggered.

The instrument should trigger when

a violation occurs. If you believe that
the instrument might have triggered
prematurely (on noise instead of a real
violation), then you may need to adjust
your mask.
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Viewing Transient Signals in Time and Frequency Domains

Spectrograms allow you to see how signals change over time. You can use the Spectrogram display to examine the transient
signals that violated the mask. Combining the Spectrogram display with the Frequency Mask Trigger allows you to see
how often the violations occur and to troubleshoot the cause of the problem.

1. Click Displays to open the Select 11 Tek RSAG1004 - [Spectrum]
DISp|ayS dla|Og bOX B Fle view Run Markers Setup Tools Window Help -8 x
F)\su\avs Warkers |[Settings |[ Trig | aca J[#na ] © Frea: 1.48200 GHe © RefLev: 0.00 dBm

1909-027

2. Add he Specrogram and Time Overview

dISplayS Folders: Avallable displays:
e iIEl . '|E‘-e‘m-‘ g -
. GP Digital Modulation Ve - ik
3' Close the dlalog box gz‘iia;%rements Arnplitude vs DPyx Frequency  Phasevs  RF IRQws Spectrogram
Time Spectrum vs Time Time Time

Time
Overview

Selected displays:

Spectrum

Remove

@ —

1909-092
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4. Select the Time Overview display.

5. Increase the Analysis Length setting until
the Time Overview display covers the
transient signal. |Analysis Length  w |1.2DD ms |ﬂ\ctual: 1.200 ms

I\ Time Overview

& 30,00 dBm

 dB/fdiv:
10,00 dB

-70,00 dEm

T
o Offset: 0,000 5 o Scale: 2,800 ms

1909-093

The Spectrogram display shows an example
of a transient signal. As you increase the
Analysis Length setting, the number of
spectrogram lines within each acquisition
also increases.

The marks along the right side of the
Spectrogram display show the beginning of
each acquisition record.

"\ /Spectrogram

S CF: 244532 GHz © Span: 20,00 MHz
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The Spectrogram display shows both time and frequency domains in a single display. The vertical axis is time, with newer
data at the bottom. The horizontal axis is frequency, covering the same span as the Spectrum display.

1. Click Markers to open the Marker
toolbar.

2. Select Add Marker to add one marker
to the display.

3. Select the Spectrum display by clicking
the title bar.

4. Make sure the checkbox for Spectrogram
Trace in the Spectrum display is checked.

The Spectrogram trace in the Spectrum
display corresponds to the line selected
in the Spectrogram display by the active
marker.

NOTE. If there is no active marker, the
Spectrogram trace in the Spectrum display
shows the bottom line from the Spectrogram
display (adjusted by the vertical Offset
control).

Quick Tip

)\ Tek RSA6100A - [Spectrum]
B Fle view Run Markers Setup Tools Window Help

-8 x

Markers < Freq: 1.48200 GHz

© ReflLey: 0.00 dBm

Add Marker: v M1
Attach to;
(in selected
dlisplay)

Add Marker

Delete Marker
All markers off

Markers

Analyzing  Acg BW: 5.00 MHz, Acg Length: 148.480 us

il Spectrurn

v Trare 1 [V]Show

I Trace 1

© 0.00 dBm
< dB/div:

Enable Trace 2
Enable Trace 3
Enable Trace 4
Enable Spectrogram Trace

-100.00 dBm

Autoscale

=~ (Fi 2,44220 GHz

Real Time _ Free Run

+Peak Max Hold

v RBV\, k
J P ‘ﬂﬂr |- "

1909-032

M2 M3 M

Readouts: | Absclute b

=) ©

Ref: Int  Atten: 10 dB  Preamp: On, max 3GHz
1909033

e TS e P

~ Span: 18,60 MHz

1909-096

Qverlap: 0 %

+Peak Normal Clear

© Scale:
0

© RRAW:
100 Kz

= Offset:

EE&@E o

“ Spectrog  [¥]Show
“ 0.00 dBm
@ dBjdiv:
10,00 de
~ RBW
100 iz

-

© CF; 244220 GHz © Span: 18.60 MHz

Autoscale

-100.00 dBrn

Autoscale

© (R 2.44220 GHz “ Span: 18,60 MHz

1909-097

B Spectrum traces 1, 2, 3, and 4 show the spectrum for the Spectrum Time selected in the Time Overview display or in the
Spectrum Time tab of the Analysis control panel. The Spectrogram, by comparison, covers the Analysis Time selected in
the Time Overview display or in the Analysis Time tab of the Analysis control panel.
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Pulse Measurements

Applications

Pulsed RF measurements have historically been difficult to perform. Some measurements required custom-built and
dedicated test tools. These custom-built tools required trained experts to properly use the tools to achieve accuracy and
repeatability. Tektronix real-time spectrum analyzers have revolutionized taking pulse measurements through automation. An
RSAG100A Series Spectrum Analyzer, with Option 20 installed, can replace specialized test equipment formerly required for

pulsed RF measurements.

This application shows how to accomplish the following pulsed RF measurements:

B Capture a series of RF pulses in a single acquisition record.

= Select measurements to display in a pulse table.

®  Examine the pulse shape and measure reference points with the Pulse Trace display.

= View Trend and FFT analysis on the measurement results with the Pulse Statistics display.

NOTE. To complete the following example, you will need a pulsed signal or an appropriate saved data record. This example
uses the PulseDemo.tiq file, which is located in the folder C:\RSA6100A Files\Sample Data Records.

Capture the pulses

1. Push the Preset button on the front
panel to set the instrument to the default
settings.

2. Adjust the instrument controls to view
the waveform on the screen.

3. Click Displays to open the Select
Displays dialog box.

RSAB6100A Series Quick Start User Manual

Touch Screen

)\ Tek RSA6100A - [Spectrum]
B Fle view Run Markers Setup Tools Window Help

F)\su\avs Markers ||Settings || Trig || Acg | Ana | = Freq: 1.48200 GHz

© ReflLey: 0.00 dBm

®

1909-055
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4. Select the General Signal Viewing folder.

5. Select the Time Overview icon and add
the application to the Selected Displays
list.

6. Select the Pulsed RF folder.

7. Add the Pulse Table and Pulse Trace
displays to the Selected Displays list.

8. Click OK to close the dialog box.
9. Set the Frequency to 2.7 GHz.

10. In the Time Overview display, set the
Analysis Length to include several
pulses.

Only complete pulses are recognized.
Complete pulses are defined as pulses
from the rising edge of one pulse to the
rising edge of the next pulse.

For example, the last pulse within the
highlighted area is not a complete pulse
because the second rising edge is not
within the measurement area.

70

[ Select Displays 5 EEX

Folders: Avallable displays:
5is

E |
DPyx

ol
RF Measurernents

Pulsed RF Amnplitude vs Frequency Phase vs RF I2Q w5 Spectrogram
Time Spectrum vs Time Time Time

Time
Overview

Selected displays:

Spectrum

1909-098

[ Select Displays (M=1E3]
Folders: Avalable displays:
General Signal Viewing
GP Digital Modulation %

RF Measurermnents

Pulse: Pulse Tahle  Pulse Trace

Statistics

Selected displays:

T
Spectrum Time
Overview m

]

1909-099

T\ Time Qverview

| nalysis Lemgth v |300.000 us | actual: 300.000 us

& 0.00 dBm ‘

< dBfdiv
10,00 de

-100,00 dem

=
o Offset: 0,000 5

v Scale: 600,000 us
1909-100
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11. Select the Pulse Table display and then 7 Tek RSAB100A - [Spectrum] OEx

SeleCt settings Bl Fle View Run Markers Setup Tools Window Help
’ Markers ||Settings || Trig || Acg || Ana | ¢ Freq: 1.48200 GHz % RefLey: 0.00 dBm

a0

12. Select the Measurements tab. Pulse Table | Measrenents | params | method | Fonts

Settings

1908095

[ awerage Transmitted Povwrer
Pulss Width

Show in Pulse Table:

13. Select the measurements that you are

interested in. (For this example, select @ r«se Time A
. Fall Tirne
Average ON Power, Pulse Width, and  Eitepetn ptore 5 |
Rise Time).
Run Acg BW: 10.24 MHz, Acg Length: 800,000 us Real Time Free Run Ref: Int | Atten: 20 dB

1900-101

14. Close the control panel.

15. When you see the data in the Pulse Table
display, click Run to stop acquiring data.

Quick Tip

B You can take measurements while the instrument is running or while it is stopped. Stopping the instrument may make it
easier to read the measurements from already captured data.

RSAB6100A Series Quick Start User Manual 71



Applications

72

Measure the Parameters of the Captured Pulses

After you have captured the pulses, you can use the Pulse Trace display to view the details of specific measurements.

I\ Pulse Table =13

1.

Select one of the measurement results
in the Pulse Table display. For example,
click the cell for the Width measurement
of Pulse 1.

The Pulse Trace display shows an
amplitude versus time trace for the
selected result on the selected pulse.
Blue lines and arrows show how the
measurement was made.

The green arrow in the display shows the
power threshold used to detect pulses. If
this threshold is set too high or too low,
no pulses will be detected. You can set
the power threshold on the Settings >
Params tab.

v

Pulze Avig OM Width Rise 2

3 -2.24 dBm 4.633 us 100.0 ns

-2 -2.84 dBm 4,639 us 101.6ns

-1 -2.83 dBm 4.642 Uz 98.70 ns

u} -2.84 dBm 4,636 Ls 87.85ns

I -2.84 dBm 01.23 ns

2 -2.24 dBm 4.632 us 99.94 ns
3 -2.84 dBm 4.639 1018 ns v

Freq Errar; -1 (Auto)

1909-102

J\Pulse Trace |:|[E|EJ

v © 0,00 dBm
Result: o dejdiv:
width - 10.00 dB
“ Pulse 1
4,631 us
-100.00 dBem
@ 17,602 us @ Scale: 6.563 us

1909-103
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2. Click the Pulse control in the Pulse
Trace display and enter a different pulse
number.

The new pulse appears in the Pulse
Trace display and is selected in the
Pulse Table display. You can use the
Pulse Trace display and the Pulse Table
display together to view and analyze
pulse measurements.

You can select a different result in the
Pulse Trace display and it will also be
selected in the Pulse Table display.

3. Use the Scale and Offset controls to
zoom in on details of the selected pulse.
For example, you can adjust the controls
to get a close look at the details of the
Rise Time measurement as shown.

Quick Tip

) Pulse Trace |:|@@

v © 000 dBm
Result: © defdiv:
[width |+ 10.00 de
2 Pulse 4
4.642 us
1 -100.00 dem
© 215686 us © Scale! 6,563 us

1909-104

[\ /Pulse Trace |:|@@J

v © 5,00 dBm
Result: = defdiv:
Rise v| 10.00 d&
“ Pulse 4
98.18 ns
-75.00 dém
o 214.971us © Scale: 4.032 us

1909-106

= (Click Autoscale to optimize the vertical and horizontal offset and scale settings.

m  When using scale or offset, adjust the offset control to move the area of interest to the far left side of the screen,

and then adjust the scale to expand the area of interest.
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Review Measurement Statistics Across all Measured Pulses

You can use the Pulse Statistics display to show the trend or an FFT across all measured pulses. To get the best frequency
resolution and dynamic range in the display, you need to include many pulses in the analysis period. The following example
uses a minimum of 100 pulses in the analysis period.

1. Set the Analysis Length in the Time
Overview display to 2 ms. This allows
you to use over 120 pulses during the
analysis period.

2. Click Displays to open the Select
Displays dialog box.

3. Select the Pulsed RF folder.

4. Remove the Spectrum icon and the
Time Overview icon from the Selected
Displays list.

5. Add the Pulse Statistics icon to the
Selected Displays list.

6. Close the dialog box.

74

I\ Time Overview

|ﬂ\nalvsis Length |2.4DD ms

| Actual: 2,400 ms

& 0.00 dBm

< dBfdiv
10,00 de

-100,00 dem

v Offset: 0,000 s

-

=
v Scale: 2,040 ms

)\ Tek RSA6100A - [Spectrum]
B Fle view Run Markers Setup Tools Window Help

1909-106

EEx

g x

F)\su\avs Markers ||Settings || Trig || Acg |{ Ana | = Freq: 1.48200 GHz

© ReflLey: 0.00 dBm

@

1909-077

[ Select Displays (=13
Folders: Available displays:
General Signal Viewing
GP Digital Modulation

RF Measurernents

Pulse
Statistics

®

A

®

Selected displays:

H R B 0

Pulse Table Pulse Trace  Spectrum Time
Qvervigw

®

]

1909-107
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The Pulse Statistics display plots the
results of the selected measurement for
every measured pulse.

. Select the Phase measurement.

Pulse-to-pulse phase measurements are
good examples to show the trend and
FFT statistics.

. Change the Statistics trace to FFT.

FFT shows a spectrum-like trace of the
amplitude (in dB relative to the highest
result in the set) vs frequency. This can
be useful for identifying interference in
the pulsed signal. For example, if a spike
appears around 60 Hz, it might indicate
coupling from the AC power supply.
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e
Result:
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“ Pulse 4
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Result:
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o Scaler 31,040 kHz

1309-109
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Accessories
documents, 1
optional, 2
power cords, 1
standard, 1
Acquisition
conflicts, 43
controlling, 42
data source, 23
starting, 30
stopping, 30
Analysis length, 58
Analysis offset, 59
Analysis window, 22, 24
Applications, 55
capturing transient signals, 60
modulation analysis, 55
pulse measurements, 69
audio demodulation, 51

C

Cleaning procedures, 11
Conflicts

measurement, 43
Connectors

front panel, 16

rear panel, 17

RF signal input, 28, 29
Constellation display, 57
Controlling acquisitions, 42
Controls

display-specific, 20

front panel, 13

interface, 18
Cooling clearances, 3
correction tables, 49

D

Data
recalling, 36
saving, 35
Default settings, 28
Diagnostics, 10
Digital demodulation displays, 24
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Display
conflicts, 43
Display properties
changing, 9
Display settings
changing, 27
Displays
Constellation, 57
DPX Spectrum, 61
general signal viewing, 24
GP Digital Modulation, 24
printing, 34
Pulse Statistics, 74
Pulse Trace, 72
Pulsed RF, 24
RF measurement, 24
selecting, 25
Signal Quality, 57
Spectrogram, 66
Time Overview, 58
Documentation, vi
Tektronix part numbers, 1
DPX Spectrum display, 61

E

Environmental specifications, 3
altitude, 3
cooling clearances, 3
humidity, 3
temperature, 3

EVM, 57

Extended desktop, 6

external gain/loss correction, 49

External monitor, 6

F

Features, vi
File types, 36
Free Run trigger mode, 37
Frequency mask
Mask Editor, 39
triggering, 37, 64
Front panel
connectors, 16
controls, 13

G

General signal viewing displays, 24

Graphics driver, 9

Incoming inspection, 10
Information messages, 26
Input requirements
frequency range, 29
input impedance, 29
power, 29
RF signal range, 29
voltage, 29
Installation, 1
network connections, 4
Italicized numbers, 21

K

Key features, vi

Maintenance
cleaning procedures, 11
repackaging, 11
Marker toolbar, 32

Markers, 30
absolute, 31
adding, 33
defining, 33
delta, 31
shapes, 31

Mask Editor

adding points, 39

editing points, 40
Max Hold, 60, 63
Max Trace, 63
Measurement

conflicts, 43
Mechanical specifications, 3
Messages

on-screen, 26
Modulation analysis, 55

N

Network connections, 4
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Optional accessories, 2
Options, 2
Power cords, 1

P

Part numbers, manuals, 1
Power cord options, 1
Power level triggering, 37
Power supply, 3
Preset, 28

system settings, 28
Printing, 34
Product features, vi
Pulse measurements, 69
Pulse Statistics display, 74
Pulse Trace display, 72
Pulsed RF displays, 24

R

Real-Time spectrum analyzer, 22
Rear panel connectors, 17
Recalling data, 36

Repackaging, 11

Returning the instrument, 11

RF measurement displays, 24
RF signal connections, 28, 29
RF signal input range, 29

Run control, 30

Run menu, 30

S

Safety Summary, iii
Save options, 36
Saving data, 35
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Screens, printing, 34
Search, 46
Selected window, 42
Selecting displays, 25
Settings
changing, 27
default, 28
preset, 28
Setups
recalling, 36
saving, 35
Signal Quality display, 57
Software upgrades, vii
installing, 11
Specifications
altitude, 3
cooling clearances, 3
environmental, 3
humidity, 3
input requirements, 29
mechanical, 3
power supply, 3
product dimensions, 3
temperature, 3
Spectrogram display, 66
Spectrum analyzer
real-time concepts, 22
Spectrum length, 58
Standard accessories, 1
documents, 1
power cord, 1
Starting acquisitions, 30
Stopping acquisitions, 30

.

Time Overview display, 58
Transient signals, 60

Trigger
control panel, 38
mask, 39
violations, 41
Trigger Event parameters, 37
accessing, 38
Triggered trigger mode, 37
Triggering
free run, 37
frequency mask, 37, 64
parameters, 37
power level, 37
triggered, 37

U

Upgrades
software, vii, 11

vV

Violations
trigger mask, 41

W

Window
analysis, 22
selected, 42
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